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Safety Information

Important Information
Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

Before You Begin
Do not use this product on machinery lacking effective point-of-operation
guarding. Lack of effective point-of-operation guarding on a machine can result in
serious injury to the operator of that machine.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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WARNING
UNGUARDED EQUIPMENT
• Do not use this software and related automation equipment on equipment

which does not have point-of-operation protection.
• Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

This automation equipment and related software is used to control a variety of
industrial processes. The type or model of automation equipment suitable for each
application will vary depending on factors such as the control function required,
degree of protection required, production methods, unusual conditions,
government regulations, etc. In some applications, more than one processor may
be required, as when backup redundancy is needed.

Only you, the user, machine builder or system integrator can be aware of all the
conditions and factors present during setup, operation, and maintenance of the
machine and, therefore, can determine the automation equipment and the related
safeties and interlocks which can be properly used. When selecting automation
and control equipment and related software for a particular application, you should
refer to the applicable local and national standards and regulations. The National
Safety Council's Accident Prevention Manual (nationally recognized in the United
States of America) also provides much useful information.

In some applications, such as packaging machinery, additional operator protection
such as point-of-operation guarding must be provided. This is necessary if the
operator's hands and other parts of the body are free to enter the pinch points or
other hazardous areas and serious injury can occur. Software products alone
cannot protect an operator from injury. For this reason the software cannot be
substituted for or take the place of point-of-operation protection.

Ensure that appropriate safeties and mechanical/electrical interlocks related to
point-of-operation protection have been installed and are operational before
placing the equipment into service. All interlocks and safeties related to point-of-
operation protection must be coordinated with the related automation equipment
and software programming.

NOTE: Coordination of safeties and mechanical/electrical interlocks for point-
of-operation protection is outside the scope of the Function Block Library,
System User Guide, or other implementation referenced in this
documentation.

Start-up and Test
Before using electrical control and automation equipment for regular operation
after installation, the system should be given a start-up test by qualified personnel
to verify correct operation of the equipment. It is important that arrangements for
such a check are made and that enough time is allowed to perform complete and
satisfactory testing.

WARNING
EQUIPMENT OPERATION HAZARD
• Verify that all installation and set up procedures have been completed.
• Before operational tests are performed, remove all blocks or other temporary

holding means used for shipment from all component devices.
• Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Follow all start-up tests recommended in the equipment documentation. Store all
equipment documentation for future references.

Software testing must be done in both simulated and real environments.

Verify that the completed system is free from all short circuits and temporary
grounds that are not installed according to local regulations (according to the
National Electrical Code in the U.S.A, for instance). If high-potential voltage
testing is necessary, follow recommendations in equipment documentation to
prevent accidental equipment damage.

Before energizing equipment:
• Remove tools, meters, and debris from equipment.
• Close the equipment enclosure door.
• Remove all temporary grounds from incoming power lines.
• Perform all start-up tests recommended by the manufacturer.

Operation and Adjustments
The following precautions are from the NEMA Standards Publication ICS 7.1-1995
(English version prevails):

• Regardless of the care exercised in the design and manufacture of equipment
or in the selection and ratings of components, there are hazards that can be
encountered if such equipment is improperly operated.

• It is sometimes possible to misadjust the equipment and thus produce
unsatisfactory or unsafe operation. Always use the manufacturer’s
instructions as a guide for functional adjustments. Personnel who have
access to these adjustments should be familiar with the equipment
manufacturer’s instructions and the machinery used with the electrical
equipment.

• Only those operational adjustments actually required by the operator should
be accessible to the operator. Access to other controls should be restricted to
prevent unauthorized changes in operating characteristics.
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About the Book

Document Scope
This manual describes the following Momentum processors for Control Expert:

• 171 CBU 78090
• 171 CBU 98090
• 171 CBU 98091

Validity Note
The Momentum 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091
processors described in this manual require the use of EcoStruxure™ Control
Expert 15.1 or later.

Related Documents
Title of Documentation Reference Number

Modicon Momentum I/O Base User Guide 31001697 (English), 709604 (French), 709136
(German), 31007277 (Italian), 31002238
(Spanish), 31007104 (Chinese)

EcoStruxure™ Automation Device Maintenance,
User Guide

EIO0000004033 (English), EIO0000004048
(French), EIO0000004046 (German),
EIO0000004049 (Italian), EIO0000004047
(Spanish), EIO0000004050 (Chinese)

Unity Loader, User Guide 33003805 (English), 33003806 (French),
33003807 (German), 33003809 (Italian),
33003808 (Spanish), 33003810 (Chinese)

You can download these technical publications and other technical information
from our website at www.se.com/ww/en/download/ .
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Introducing the 171 CBU 78090, 171 CBU 98090 &
171 CBU 98091 Processors

Overview
This chapter introduces the 171 CBU 78090, 171 CBU 98090, and 171 CBU
98091 processors.

Momentum 171 CBU 78090, 171 CBU 98090 & 171 CBU 98091
Processors for Control Expert

Overview

This section describes the user benefits presented by the Momentum 171 CBU
78090, 171 CBU 98090 and 171 CBU 98091 processors in Control Expert.

Adding the Momentum 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 Processors
to Control Expert

Momentum Comes to Control Expert

With the release of the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091
processors, Schneider Electric introduces to Control Expert low-cost, yet powerful
Momentum CPUs. This release provides customers with the following benefits:

• For Control Expert users:
◦ Enjoy the cost savings of adding powerful Momentum processors to your

existing applications.
◦ Continue to use Control Expert to develop, monitor, and troubleshoot your

existing applications.
• For Momentum users, use Control Expert to:
◦ Continue to program your Momentum projects using the LL984

programming language.
◦ Add program tasks created with the IEC languages – including Ladder

Diagram (LD), Function Block Diagram (FBD), Structured Text (ST),
Instruction List (IL), and Sequential Function Chart (SFC) – to your
existing control network projects.

◦ Add powerful M340, M580, Premium, and Quantum platform CPUs to your
existing projects, which you can now develop, monitor and troubleshoot
with Control Expert.

The 171 CBU 78090 Processor

Overview

This section describes the basic features of the 171 CBU 78090 processor.

171 CBU 78090 Processor Physical Description

Key Features

The key features of the 171 CBU 78090 processor include:
• memory retention of application program and data without a battery
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98091 Processors

• embedded real time clock: sustainable for 72 hours without external power,
via a maintenance-free super capacitor

• support for the following communication protocols:
◦ Modbus Serial RS485
◦ Modbus Serial RS232

• I/O-Bus port with DB9 connector
• 2 RJ45 connector ports:
◦ 1 fixed RS485 2-wire port
◦ 1 configurable RS232/RS485 2-wire port

• diagnostic web pages accessible via USB
• diagnostic LEDs for I/O, serial communication, and CPU status

Port and LED Locations

The processor communication ports and LEDs:

1 serial RS485 fixed port with RJ45 connector

2 serial RS232/485 configurable port with RJ45 connector

3 USB port with mini-B connector

4 I/O-Bus port with DB9 F connector

5 LED panel

LEDs

The processor features the following LED panel display:

Each LED on the panel indicates the following:
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LED Color Indicates...

RUN green CPU operating status

ERR red Error detected in module operation

I/O red Error detected on the local base or remote I/O-Bus

MB1 CH0 yellow Communication activity on the configurable RS232/RS485 serial port,
channel 0

MB2 CH1 yellow Communication activity on fixed RS485 serial port, channel 1

NOTE: Refer to the section LED Diagnostics, page 86 for information
describing how to use the LEDs to diagnose the state of the processor and I/O
operations.

171 CBU 78090 Processor Specifications

Processor Specifications

Specification Description

Module number 171 CBU 78090

Temperature Operating 0°...60° C (32°...140° F)

Storage –40°...85° C (–40°...185° F)

Humidity maximum 96% (non-condensing)

Altitude 2000 m (6500 ft)

Power

(from I/O base)

Voltage 5 Vdc

Current 500 mA maximum

Hot swap capable? No

Dielectric strength 1500 Vrms (1500 Vac, 2100 Vdc) between logic common and ground

Retention memory capacity 128 K bytes

User application memory 3590 K bytes

CPU clock speed 333 MHz

Real Time Clock Accuracy Powered 16 minutes per year (without calibration)

Non-powered 6 seconds per 72 hours (retention duration)

Retention time 72 hours

Battery none required (embedded super capacitor)

Communication ports 1 - RS232/RS485 configurable serial port (channel 0)

1 - RS485 fixed serial port (channel 1)

1 - USB port

1 - I/O-Bus port

The 171 CBU 98090 and 171 CBU 98091 Processors

Overview

This section describes the basic features of the 171 CBU 98090 and 171 CBU
98091 processors.
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171 CBU 98090 and 171 CBU 98091 Physical Description

Key Features

The key features of the 171 CBU 98090 and 171 CBU 98091 processors include:
• memory retention of application program and data without a battery
• embedded real time clock: sustainable for 72 hours without external power,

via a maintenance-free super capacitor
• support for the following communication protocols:
◦ Modbus Serial RS485
◦ Modbus Serial RS232

• I/O-Bus port with DB9 connector
• 2 RJ45 connector ports:
◦ 1 configurable RS232 / RS485 serial port
◦ 1 Ethernet port

• diagnostic web pages accessible via USB and Ethernet
• diagnostic LEDs for I/O, serial port, Ethernet port, and CPU status

Port and LED Locations

The processor communication ports and LEDs:

1 Ethernet port with RJ45 connector

2 serial RS232/485 configurable port with RJ45 connector

3 USB port with mini-B connector

4 I/O-Bus port with DB9 F connector

5 LED panel
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LEDs

The processors feature the following LED panel display:

The processor LEDs indicate the following:

LED Color Indicates...

RUN green CPU operating status

ERR red Error detected in module operation

I/O red Error detected on the local base or remote I/O-Bus

MB1 CH0 yellow Communication activity on the configurable RS232/RS485 serial
port, channel 0

ETH 100 green Ethernet port speed
• ON: 100mbps
• OFF: 10mbps

ETH STS green An Ethernet link is established, or an error is detected.
NOTE: If an error is detected, the LED flashes to indicate the
nature of the detected error., page 87

ETH LNK/ACT green The presence of communication activity on the Ethernet port

NOTE: Refer to the section LED Diagnostics, page 86 for information
describing how to use the LEDs to diagnose the state of the processor and I/O
operations.

171 CBU 98090 and 171 CBU 98091 Specifications

Processor Specifications

Specification Description

Module number • 171 CBU 98090
• 171 CBU 98091 (with Global Data service)

Temperature Operating 0°...60° C (32°...140° F)

Storage –40°...85° C (–40°...185° F)

Humidity maximum 96% (non-condensing)

Altitude 2000 m (6500 ft)

Power

(from I/O base)

Voltage 5 Vdc

Current 500 mA maximum

Hot swap capable? No

Dielectric strength 1500 Vrms (1500 Vac, 2100 Vdc) between logic common and ground

Retention memory capacity 128 K bytes

User application memory 3590 K bytes

CPU clock speed 333 MHz
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Specification Description

Real Time Clock Accuracy Powered 16 minutes per year (without calibration)

Non-powered 6 seconds per 72 hours (retention duration)

Retention time 72 hours

Battery none required (embedded super capacitor)

Communication ports 1 - RS232/RS485 configurable serial port (channel 0)

1 - Ethernet port (channel 3)

1 - USB port

1 - I/O-Bus port

Agency Standards

Overview

This section lists the agency standards that apply to the 171 CBU 78090, 171
CBU 98090 and 171 CBU 98091 processors.

Agency Standards and Certifications

Agency Standards

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors meet the
following agency standards:

• CE (EMC and LV European directives)
• IEC 61131-2 Ed 3
• UL 508
• CSA 22.2 No. 142
• RCM
• EAC
• FM approved Class I, Division 2, Groups A, B, C, and D
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Communication Ports on 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 Processors

Introduction
This chapter describes the communication ports of the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors.

Serial Ports

Overview

This section describes the serial ports included on the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors.

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 Serial Port Locations

Physical Locations

The 171 CBU 78090 processor includes both a configurable RS232/RS485 serial
port and a fixed RS485 serial port. The 171 CBU 98090 and 171 CBU 98091
processors include a single configurable RS232/RS485 serial port.

The location and type of serial port depends on the processor:

Serial Port Processor Serial Port Type

1 171 CBU 78090 RS485 fixed

2 171 CBU 78090 RS232/RS485 configurable

171 CBU 98090 RS232/RS485 configurable

171 CBU 98091 RS232/RS485 configurable

Each serial port features an RJ45 female connector. A serial port configured for
RS485 supports 2-wire communications.

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 Serial Port Parameters

Modbus Mode versus Character Mode

The serial ports can operate in either Modbus mode or character mode.

HRB44124.09 17
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and 171 CBU 98091 Processors

When operating in Modbus mode, the serial port can be accessed by:
• local HMI for management and diagnostics
• a programming PC, for maintenance and diagnostics
• a modem connected to a central location for SCADA and data collection via

RS232
When operating in character mode, you can use a serial port to:

• Send ASCII characters to a printer or a modem.
• Display data on the screen of a terminal and receive data from its keyboard.

Configuring Modbus versus Character Mode

By default, the serial ports operate in Modbus mode, but can be switched to
character mode using the L9_XMIT or XXMIT instruction in the application
program. When the instruction is completed, the serial port remains in character
mode. To return to Modbus mode, cycle power to the processor or download the
original configuration to the processor.

In Modbus mode, the serial port communicates using the Modbus protocol. In
Modbus mode, you can use the XXMIT EF block in Control Expert to:

• Designate each serial port to serve as either a Modbus master or slave.
• Specify the signaling protocol that will be used by the RS282/RS485

configurable serial port.
NOTE: When using XMIT, L9_XMIT, or XXMIT EF blocks on the two serial
ports of the 171 CBU 78090 CPU, create an EF block instance for each port.
Do not dynamically change the port number. Set the port number as an initial
value for each instance because the block stores one single port
configuration.

Port Parameters

The RS282/RS485 configurable serial port and the RS485 fixed serial port present
the following properties and range of settings when operating in Modbus mode:

Parameter Settings Include...

signaling protocol • fixed serial port
◦ RS485 (fixed)

• configurable serial port
◦ RS232
◦ RS485 (default)

operations mode • slave (default)
• master (using the XXMIT instruction)

baud rate • 300
• 600
• 1200
• 2400
• 4800
• 9600 (default)
• 19200

parity • even (default)
• odd
• none

mode/data bits • 8-bit RTU (default)
• 7-bit ASCII
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Parameter Settings Include...

stop bit • 1 (default)
• 2

Modbus address • 1...247
• 248 indicating point-to-point addressing

Default = 1

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 Serial Port Pin Assignment

Pin Assignment

Each serial port–the fixed RS485 port and the configurable RS232/RS485 port–
uses an RJ45 female connector. Pins are positioned within the female RJ45
connector for each serial port as follows:

The specified standard–RS232 or RS485–determines the signal assigned to each
pin for serial communications:

RJ45 Pin Number Signal Type

RS232 RS485

1 DTR (data terminal ready) Reserved

2 DSR (data set ready) Reserved

3 TXD (transmitted data) D1

4 RXD (received data) Reserved

5 GND (common ground) GND

6 RTS (request to send) D0

7 CTS (clear to send) Reserved

8 Cable shield Cable shield

NOTE: The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 RJ45
serial port pin assignments are compatible with serial port pin assignments of
legacy Momentum CPUs. However, these pin assignments differ from the
M340 family of CPUs.

Serial Cabling Components

You can purchase the following serial cabling components from Schneider
Electric:

Part Number Length Description Connector

110XCA28203 6 m Momentum programming cable for M1 RJ45

170MCI04110 0.3 m RS485 master communication cable RJ45

170XTS04000 – RS485 cable connector T DB9/RJ45(2)

170XTS04100 – RS485 T junction cable connector RJ45

170XTS04200 – RS485 multi master shunt plug RJ45
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Ethernet Port

Overview

This section describes the Ethernet port included on the 171 CBU 98090 and 171
CBU 98091 processors.

171 CBU 98090 and 171 CBU 98091 Ethernet Port Location

Physical Location

The 171 CBU 98090 and 171 CBU 98091 processors have a single Ethernet port
at the location indicated, below:

1 Ethernet port

The Ethernet port features an RJ45 female connector.

171 CBU 98090 and 171 CBU 98091 Ethernet Port Features

Ethernet Port Uses

The Ethernet port supports the following types of communication:
• peer communications with other Momentum PLCs
• communication with a higher-level PLC: The Ethernet port can be polled by–

or push data to–a higher-level PLC.
• SCADA/HMI communication: The Ethernet port can be polled by a SCADA or

HMI for monitoring, and can push data to a SCADA via an unsolicited write
transaction.

• communication with devices and systems on other networks: for example via
a gateway

• I/O scanning, programming, monitoring, and maintenance over the plant
network

• Global Data service for the 171 CBU 98091 processor

Ethernet Port Features

The features of the Ethernet port include:

Feature Description

Addressing • Unique IEEE global (MAC) address
• User assigned IP address

Application protocols supported • DHCP/BootP
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Feature Description

• Global Data (on the 171 CBU 98091 processor)
• HTTP (web server)
• I/O scanner
• Modbus protocol messaging
• SNMP

Auto MDI/MDI-X Supported

Auto negotiation Supported

Connector type Shielded RJ45 female

Max connections: Modbus TCP (port
502)

• 16 connections over the Ethernet port
• 4 connections over the USB port

Max connections: web (HTTP) 2

Max client requests per cycle 4

Max server requests per cycle 4

Max message length • 1026 bytes (on Ethernet or USB) including network
headers

• 253 for Modbus requests
• 1019 for UMAS protocol requests

Max message throughput for Modbus
TCP

The Ethernet Environment (or CPU load) identified in the
Bandwidth window:

• Isolated
• Mastered
• Open

Ethernet Services

The Ethernet port supports the following Ethernet services:
• IP address configuration from any of the following sources:
◦ DHCP or BootP server
◦ Control Expert configuration, page 63

• Global Data for the 171 CBU 98091 processor, page 70
• Modbus Messaging and Access Control, page 64
• SNMP agent, page 73
• Bandwidth Monitoring, page 75
• I/O Scanning, page 67 for up to 32 devices

171 CBU 98090 and 171 CBU 98091 Ethernet Port Pin Assignment

Pin Assignment

The Ethernet port uses an RJ45 female connector. Pins are positioned within the
female RJ45 connector for the Ethernet port as follows

The Ethernet signals assigned to each pin include:
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RJ45 Pin Number Ethernet Signal

1 TD+ (Transmit data +)

2 TD– (Transmit data –)

3 RD+ (Receive data +)

4 Not connected

5 Not connected

6 RD– (Receive data –)

7 Not connected

8 Not connected

Ethernet Cables

You can purchase the following Ethernet cables from Schneider Electric:

Part Number Length Description Connector Marking

TCSECE3M3M1S4 1 m Cat 5e shielded, twisted pair straight cable RJ45 CE

TCSECU3M3M1S4 1 m Cat 5e shielded, twisted pair straight cable RJ45 UL

TCSECE3M3M2S4 2 m Cat 5e shielded, twisted pair straight cable RJ45 CE

TCSECU3M3M2S4 2 m Cat 5e shielded, twisted pair straight cable RJ45 UL

TCSECE3M3M3S4 3 m Cat 5e shielded, twisted pair straight cable RJ45 CE

TCSECU3M3M3S4 3 m Cat 5e shielded, twisted pair straight cable RJ45 UL

TCSECE3M3M5S4 5 m Cat 5e shielded, twisted pair straight cable RJ45 CE

TCSECU3M3M5S4 5 m Cat 5e shielded, twisted pair straight cable RJ45 UL

TCSECE3M3M10S4 10 m Cat 5e shielded, twisted pair straight cable RJ45 CE

TCSECU3M3M10S4 10 m Cat 5e shielded, twisted pair straight cable RJ45 UL

Assigning IPAddressing Parameters to the 171 CBU 98090 and 171 CBU 98091

IPAddressing Parameters

When a new 171 CBU 98090 or 171 CBU 98091 processor is shipped from the
factory, it does not come with pre-configured IP address settings. IP address
settings include:

• IP address
• subnet mask
• default gateway

First Power-Up

When you first connect the processor to an Ethernet network and power it up, it
transmits a request for IP address settings. The BOOTP request can be handled
by either a BOOTP or a DHCP server.

If both of the following conditions exist, the server assigns the processor its IP
address settings:

• A BOOTP or DHCP server exists on the network.
• The server is configured to recognize the processor by its MAC address.
NOTE: Consult with your system administrator to determine if a BOOTP or
DHCP server exists on your network. Your system administrator can help you
configure the server to maintain the processor IP address settings.
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If no BOOTP or DHCP server exists on your network – or the server is not
configured to deliver IP address settings to the processor – the processor assigns
itself a default IP address.

Deriving a Default IPAddress from a MAC Address

The processor derives its default IP address from its factory-assigned MAC
address. The MAC address for the processor is displayed on the front of the
module.

The default address is in the format 10.10.x.y, where x and y are derived from the
last 2 octets of the MAC address.

To determine the default IP address of a module, follow these steps:

Step Action

1 Using a sample MAC address of 00-00-54-10-25-16, ignore the first 4 pairs (00-00-54-
10).

2 Convert the subsequent pairs (25 and 16) from
hexadecimal to decimal format.

25: (2 x 16) + 5 = 37

16: (1 x 16) + 6 = 22

3 Use the specified format (10.10.x.y.) to assemble the
derived default IP address.

The default IP address is:
10.10.37.22

NOTE: There are many resources for converting hex numbers to decimal
numbers. For example, you can use the Windows calculator in scientific
mode.

Assigning New IPAddress Settings

After first power-up, you can connect to the processor as follows:
• via Ethernet using the default IP address, page 23
• via USB using the fixed IP address 90.0.0.1
• via the Modbus serial port

After a connection has been established, you can use Control Expert to transfer a
configuration file to the processor, including new IP address settings.

NOTE: Configure IP parameters in Control Expert, page 63, then transfer the
configuration file to the CPU over the USB port, page 24.

USB Port

Overview

This section describes the USB port included on the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors.
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171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 USB Port Location

Physical Location

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors include a
USB port.

1 USB port

The USB port mini-B connector.

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 USB Port Features

Using the USB Port

Use the USB port as follows:
• to connect the processor to Control Expert using the following connection

settings:
◦ Communication Selection: USB; Address: SYS, or
◦ Communication Selection: TCP/IP; Address: 90.0.0.1

• to perform processor firmware upgrades, using the USB communication
selection

• to access processor web pages at IP address 90.0.0.1
The USB port provides an electrically isolated interface, and serves as the default
port for connecting a PC to the 171 CBU 78090, 171 CBU 98090 and 171 CBU
98091 processor. When you connect a PC to the processor USB port, the
processor becomes a USB peripheral device and the PC acts as the USB host.

For communications between the PC and processor over the USB port:
• 90.0.0.1 is the fixed IP address of the processor.
• 90.0.0.2 is the IP address of the PC.

Use Control Expert to perform:
• on-line application programming
• application debug
• the on-line commands: RUN, STOP, READ, and WRITE

Use Automation Device Maintenance or Unity Loader to perform:
• application download
• application upload
• firmware upgrade

Although you can connect your PC to only one processor at a time over the USB
port, you can create multiple connections between a processor and programs
running on your PC. For example, you can use the USB port to connect
simultaneously both an HMI application and Control Expert to the processor.
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USB Port Features

The USB port includes the following features:

Feature Description

Application protocols supported • RNDIS
• Modbus
• Umas
• FTP
• HTTP

Baud rate 12 Mbits/s (fixed)

Connector type USB mini-B

Max connections: Modbus TCP (port
502)

4 (only 1 can be used by Control Expert)

Max connections: web (HTTP) 2

Max message length 1026 bytes (including message headers)

Max message throughput for
Modbus TCP

This value is a function of the MAST cycle, and equals:

(MAST cycle) x (4 requests/cycle)

Application download rate:
• 20 K bytes/s for 1 connection
• 40 K bytes/s for 4 connections

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 USB Port Pin Assignment

Pin Assignment

The USB port uses a mini-B female connector.

The USB signals assigned to each pin include:

USB mini-B Pin Number Signal

1 VBUS (+5 V)

2 DM (Data –)

3 DP (Data +)

4 Not connected (slave)

5 GND (Signal ground)

USB Cables

Two connection cables are available to connect a PC or HMI to the processor USB
port:

• BMX XCA USB 018, 1.8 m (5.91 ft) in length
• BMX XCA USB 045, 4.5 m (14.76 ft) in length

Both of these cables are equipped with a connector at each end:
• Type A USB: connects to the console
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• Type mini B USB: connects to the processor
NOTE: It is recommended that you use a USB 2.0 shielded cable following the
USB international standard. Both the BMX XCA USB 018 and BMX XCA USB
045 are shielded cables.

I/O-Bus Port

Overview

This section describes the I/O-Bus port included on the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors.

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 I/O-Bus Port Location

Physical Location

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors include an
I/O-Bus port. The port is located in the same relative position on the processor as
on other Momentum processors. When you replace an existing processor with a
171 CBU 78090, 171 CBU 98090 or 171 CBU 98091 processor, you can
reconnect to I/O-Bus devices without having to modify the existing I/O-Bus
cabling.

1 I/O-Bus port

The I/O-Bus port DB9 female connector.

How I/O-Bus Works with Momentum Components

How Signals Are Passed

I/O-Bus operates with the master passing signals over a remote bus cable to each
slave device in series. The slaves return signals to the master over the same
cable.

How Data Is Transferred

The I/O-Bus functions as a logical shift register. The entire data stream of the
application, originating at the master, is transferred serially from slave to slave
down the remote bus. Each slave regenerates the entire stream before passing it
to the next slave in the ring. As a slave handles the stream data, it extracts the
portion that is assigned to it and adds any output data to the stream.
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Transmission Speed

Data is transmitted at the baud rate of 500 kbits/s.

Amount of Data

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors support
the following number of 16-bit words in the data stream:

Word type Maximum number

Input words 256

Output words 256

I/O-Bus Port Features

Using the I/O-Bus Port

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors act as the
I/O bus master for up to 32 I/O slave modules. The I/O modules on the bus can
have addresses from 1 to 32. The I/O module connected to the processor I/O bus
port has bus address number 1.

I/O-Bus Port Features

The I/O-Bus port includes the following features:

Feature Description

Protocol Interbus

Baud rate 500 Kbits/s

Media 24 AWG, stranded (7x32), 3 twisted pairs, insulated cable with
tinned copper (TC) conductors

Connector type DB9 female

Data integrity test CRC-16

Addressing Physical location

Mode of operation Master–continuous shift register

Topology Ring–extensible 1 level using a 170 BNO 6X1 XX branch interface
module

NOTE: On the transition from RUN to STOP states, the processors apply the
fallback setting to I/O modules – on the local or the I/O-Bus – that support this
feature.

I/O-Bus Port Diagnostics

Use the I/O LED on the processor, page 86 to help diagnose the state of the
processor.
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171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 I/O-Bus Port Pin Assignment

Pin Assignment

The I/O-Bus port uses a DB9 female connector.

The I/O-Bus signals assigned to each pin include:

I/O-Bus Pin Number Wire Color Signal

1 Yellow DO (Data out)

2 Gray DI (Data in)

3 Brown Common

4 – Not connected

5 – Not connected

6 Green DO_N (Data out negated)

7 Pink DI_N (Data in negated)

8 – Not connected

9 – Not connected

Low Profile Cables

For side-by-side mounting of the processor with I/O modules on a DIN rail or wall,
Modicon provides two specially molded low profile cables.

Part Number Length

170 MCI 007 00 11.4 cm (4.5 in)

170 MCI 100 01 100 cm (39 in)

These cables have a male 9-in D-shell connector on one end and a female 9-pin
D-shell on the other. The male connector plugs into the female I/O-Bus port on the
processor, and the female connector plugs into the male connector on the left side
of a 170 INT 110 00 Interbus communications adapter on an I/O base. Additional
cables can then be used to connect a series of I/O modules via their I/O-Bus
communication ports.

I/O-Bus Cable Connector Kit

I/O-Bus communicates over full duplex cable. For custom cable lengths,
Schneider Electric offers a cable connector kit (part number 170 XTS 009 00). The
kit includes two connectors, one male and one female, that can be soldered to a
full duplex cable of the appropriate length.

The recommended cable is Belden 8103 or equivalent.
NOTE: The connectors in the 170 XTS 009 00 kit are high profile.
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Installing the 171 CBU 78090, 171 CBU 98090 and
171 CBU 98091 Processors

Overview
This chapter shows you how to assemble, label, mount, ground, and disassemble
the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors.

Assembling the Processor

Overview

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors reside on
top of a Momentum I/O base. Both processors are designed to fit on any
Momentum I/O base.

You can snap a processor directly onto a Momentum I/O base, making
connections at the following points:

• 2 plastic locking tab extensions on the processor fit into the slots on the left
and right sides of the I/O base.

• a 12-pin female power and communication connector on the processor fits
into the 12-pin male connector on the base.

• 4 snap connectors on the top of the processor and 2 snap connectors on the
bottom of the processor fit into receptacles on the base.

For an /O base with a fixed standoff ground-nut on its printed circuit board, a
ground screw and a male-female standoff connect the processor to the I/O base.

NOTE: For a list of I/O bases that include a fixed standoff ground-nut that can
accept a ground screw and male-female standoff, refer to the list of supported
Momentum I/O bases, page 106.

The connection points on the back side of the processor:

1 locking tabs

2 12-pin female power and communications connector

3 aperture for male-female standoff and ground screw

4 snap connectors on top of processor

5 snap connectors on bottom of processor
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The connection points on the I/O base:

1 locking tab receptacles

2 12-pin male power and communications connector

3 fixed standoff ground nut (not provided on some I/O bases)

4 snap connector receptacles that connect to top of processor (on the back of the
I/O base)

5 snap connector receptacles that connect to bottom of processor
NOTE:

• You can use the Schneider Electric high vibration assembly kit, page 104
(170 XTS 120 00) to help stabilize the processors in a high vibration
environment.

• The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors do
not support the use of option adapters.

Required Tools

The only tool required to install the ground screw is a PZ 2 Phillips head
screwdriver. The recommended maximum torque on the ground screw is 0.5 Nm
(4.4 in/lb).

Installation

Electrical circuitry on the I/O base may be exposed when a Momentum processor
or other adapter is not mounted.
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DANGER
ELECTRICAL SHOCK HAZARD
• Turn off power to the I/O base whenever a processor or other adapter is not

mounted on the I/O base.
• Do not insert the power wiring connectors to the I/O base until after a

processor or other adapter has been mounted on the I/O base.
Failure to follow these instructions will result in death or serious injury.

Attaching or detaching a Momentum processor with connected communication
cables can expose remote electrical ground current.

DANGER
ELECTRICAL SHOCK HAZARD

Disconnect the I/O Bus, Ethernet, and serial cabling before attaching or
detaching a processor.

Failure to follow these instructions will result in death or serious injury.

Confirm that the standoff does not touch the electrical components on the
processor.

CAUTION
RISK OF IMPROPER GROUNDING

When using an I/O module with a fixed standoff-ground nut assembly together
with another module without this ground screw feature, do not install the
standoff into the fixed standoff-ground nut on the I/O module.

Failure to follow these instructions can result in injury or equipment
damage.

The electrical components of the processor can be damaged by static electricity.

CAUTION
RISK OF ELECTROSTATIC DISCHARGE
• Use proper electrical static discharge (ESD) procedures when handling the

processor.
• Do not touch the internal electrical components of the processor.
Failure to follow these instructions can result in injury or equipment
damage.

If the Automatic start in Run parameter is enabled, the processor begins to
operate when power is cycled.

CAUTION
UNINTENDED EQUIPMENT OPERATION
• Disconnect any outputs before installing the processor.
• Confirm that the Automatic start in Run parameter setting is de-selected

before re-connecting the outputs.
Failure to follow these instructions can result in injury or equipment
damage.
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The following diagram indicates the process for assembling the processor and I/O
base:

To install the ground screw, follow these steps:

Step Action

1 Select a clean environment for the assembly of the components.

2 Remove the power connectors from the I/O base.

3 If the I/O base includes outputs, disconnect the outputs.

4 Disconnect I/O Bus, Ethernet, and serial cables.

5 Install the male-female standoff (1) into the threaded fixed standoff ground-nut
assembly (2), located on the I/O module printed circuit board.

NOTE: The male-female standoff is part number 35004788; the fixed standoff
ground nut assembly is part number 35001482.

6 Snap the processor (3) onto the I/O base (4), gently pressing the locking tabs inward.
The locking tabs on each side of the adapter slide inside the I/O base and out through
the locking slot. The 12-pin connectors on the 2 units are mated to each other in the
process.

7 Use a PZ 2 Phillips head screwdriver to install the standard M3-6 ground screw (5)
through the top of the processor. The recommended torque on the ground screw is
0.5 Nm (4.4 in/lb).

NOTE: The ground screw is part number V10VC710306.

8 Insert the label (6) on the front of the processor, sliding the edges of the label under
the tabs that hold the label in place.
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Mounting the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091
Processors

Guidelines

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processor and I/O
base assembly can be mounted either on a DIN rail or on a panel. The processors
are designed as open equipment per IEC 1131-2, 1.4.20. Install open equipment
in industry-standard enclosures, and restrict access to authorized personnel.

Mounting on a DIN Rail

The numbers in the following illustration refer to the steps in the procedure below.

The processor assemblies are mounted on a DIN rail in the same manner as other
TSX Momentum assembles, as follows:

Step Action

1 Hook the plastic tabs on the back of the device onto the DIN rail and swing the
module down to rest against the rail.

2 Push the locking tab upward to hold the device in place.
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Mounting on a Panel

To mount the processor assemblies on a panel or wall, you need to obtain 2
mounting screws for each unit. The body of the screws should be 4 mm (0.16 in) in
diameter and at least 25 mm (0.97 in.) long. Confirm that the head of the screw
does not exceed 8 mm (0.31 in) in diameter.

1 4 x 25 mm (0.16 x 0.99 in.) mounting screw

Establishing an Electrical Ground for the 171 CBU 78090, 171
CBU 98090 and 171 CBU 98091 Processors

Establishing Grounding Connections with the I/O Base

Electrical ground connections for the processors are created with the I/O base on
which the processor is mounted. Electrical ground connections are established
during the assembly process, as follows:

• When you snap together the I/O base and the processor, an electrical ground
connection is established by touching the ground contact spring on the I/O
base to the ground contact plate on the processor.

1 ground contact spring on I/O base

2 ground contact plate on the processor
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• For an I/O base unit with a fixed ground nut, an electrical ground connection
is established when you perform the following tasks:
◦ Insert the male-female standoff into the fixed ground nut on the I/O base.
◦ Connect a ground screw to the standoff through the top of the processor.
Refer to the assembly topic for instructions on how to install the male-female
standoff and ground screw, page 30.

NOTE: A ground screw and male-female standoff can be used only with I/
O base modules that include the fixed ground nut.

NOTE: To complete your grounding connections, establish both a protective
ground (PE) and a functional ground (FE) for the I/O base. For a detailed
description of grounding considerations for Momentum I/O base units, refer to
the Modicon Momentum I/O Base User Guide.

Disassembling a Momentum Processor from an I/O Base

Tools

Use 2 screwdrivers:
• a PZ 2 Phillips head screwdriver to remove the ground screw.
• a flat-head screw driver to disengage locking tabs.

Removing an Adapter from an I/O Base

Electrical circuitry on the I/O base may be exposed when a Momentum processor
or other adapter is not mounted.

DANGER
ELECTRIC SHOCK HAZARD
• Turn off power to the I/O base whenever a processor or other adapter is not

mounted on the I/O base.
• Do not insert the power wiring connectors to the I/O base until after a

processor or other adapter has been mounted on the I/O base.
Failure to follow these instructions will result in death or serious injury.

To disassemble the processor and I/O base, follow these steps:

Step Action

1 Work in a clean environment when you disassemble the processor and I/O base assembly.

2 Remove power from the I/O base by removing the terminal connectors.

3 Remove the assembled unit from its DIN rail or panel mounting surface.

4 If the I/O base includes a fixed standoff ground nut, remove the label on the front of the
processor. Removing the label exposes the ground screw aperture located on the right
front of the processor.

NOTE: This step applies only to assemblies with an I/O base that includes a standoff
ground nut on its printed circuit board.

5 Use a PZ 2 phillips head screwdriver to remove the grounding screw.
NOTE: This step applies only to assemblies with an I/O base that includes a standoff
ground nut on its printed circuit board.

HRB44124.09 35



171 CBU 78090, 171 CBU 98090, 171 CBU 98091 Processors
Installing the 171 CBU 78090, 171 CBU 98090 and 171 CBU

98091 Processors

Step Action

6
Use the flat-head screwdriver to push in and disconnect the single locking tab on the right
side of the module (1), and the 4 locking tabs on the top of the module (2):

7
After the locking tabs have been disengaged, use the flat-head screwdriver to release the
2 stabilizing snaps (3 and 4) on the bottom of the processor:

8
To remove the processor from the I/O base, rotate the side of the processor, which was
previously detached in step 6, up and away from the base in a circular motion (5). Then
push the processor in the indicated direction (6) to disengage it from the processor:
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Step Action
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Configuring the 171 CBU 78090, 171 CBU 98090 and
171 CBU 98091 Processors in Control Expert

Overview
This chapter describes how to configure the 171 CBU 78090, 171 CBU 98090 and
171 CBU 98091 processors using Control Expert configuration software.

Creating a New Momentum Project in Control Expert

Overview

This section shows you how to create a new Momentum project in Control Expert.

Creating a New Momentum Project in Control Expert

Introduction

To create a new Momentum project in Control Expert, you need to specify:
• the Momentum CPU
• the I/O base

You may optionally apply configuration settings saved to an .XSO file.

Creating and Saving a New Momentum Project in Control
Expert

The following steps describe the creation of a project:

Step Action

1 Open Control Expert.

2 In the Control Expert main menu, select File > New....

The New Project window opens displaying a list of Schneider Electric controller types

38 HRB44124.09



Configuring the 171 CBU 78090, 171 CBU 98090 and 171
CBU 98091 Processors in Control Expert 171 CBU 78090, 171 CBU 98090, 171 CBU 98091 Processors

Step Action

3 In the PLC list at the top of the New Project window, expand the Momentum node and
select a CPU.

4 In the I/O-Base list in the New Project window, expand the Momentum Drop node and
select an I/O base.

5 (Optional) To create a project using previously saved project settings select Settings File,
then click the ellipsis button to navigate to and select a saved project settings file with an .
XSO file extension.

6
Click OK. Control Expert displays the Project Browser, below.

7 To save the project, select File > Save. The Save As dialog opens.

8 In the Save As dialog, type in a File name – which will be the name of your Control Expert
project – then click Save. Control Expert saves your project to the specified path location.

Configuring the CPU in Control Expert

Overview

This section shows you how to configure the CPU and use the State RAM
Viewer.

Configuring the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 Processors

Introduction

Use the CPU Configuration tab to:
• configure CPU start-up options
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• specify the size for different types of memory allocations
• click the Viewer button to open the State RAM Viewer , page 43

Accessing the Configuration Screen

Open the CPU configuration screen as follows:

Step Action

1
In the Project Browser, expand the Configuration and Momentum Bus nodes, and
select the CPU processor (in this example, the 171 CBU 98091 processor):

2 Using the contextual menu, select Open. The CPU properties dialog opens.

3 Select the Configuration tab.

Configuring the Processor

NOTE: You can modify the parameters of this dialog box only in offline mode.
Configuration screen for CPU operation and memory management:

The CPU includes the following settings:

Setting Description

Operating mode area

Protection of Stop command (%
I)

This function is activated by an input bit. If an input bit is
assigned and the function is selected, the processor cannot be
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Setting Description

stopped by using the PLC > Run/Stop command. Default =
de-selected.

Memory protect This function is activated by an input bit. If an input bit is
assigned and the function is selected, it prohibits the transfer
of a project into the processor and modifications in online
mode. Default =de-selected.

Timer Register The location of a %MW register to hold the value of a free
running counter. The counter is incremented every 10ms while
the CPU is in Run mode. The value is not incremented when
the CPU is in Stop mode. Default = deselected.

Automatic start in Run Select this to force the CPU to enter RUN mode in the event of
a cold start. Default = deselected.

Initialize %MWi on cold start On a cold start or download, if you select the check box
(default):

• The %MWi are handled like other global variables
(initialized to 0 or initial value, according to the current
application) in all cold start cases.

On a cold start or download, if you deselect the check box:
• If %MW were previously saved in internal flash memory

(using the %SW96 word), they are restored from internal
flash memory.

• If %MW were not saved:
◦ If the cold start is linked to a power-off, the %MW are

initialized.
◦ If the cold start is not linked to a power-off, the

current values of %MW are maintained.
NOTE: If the new (or restored) application has more %
MW than the previous one, the added %MW are set to 0.
(Non-zero initial values are not applied.)

Cold Start Only Select this to force the cold start of the application, instead of
the normal warm start. Default = deselected.

Memory management - State RAM area

Memory usage The bar graph indicates the percentage of memory in use.

%M Memory bits configurable memory size:
• default size: 1,536
• maximum size: 8,192

%I Input bits configurable memory size:
• default size: 752
• maximum size: 8,192

%IW Input words configurable memory size:
• default size: 256
• maximum size: 26,048

%MW Memory words configurable memory size:
• default size: 1,872
• maximum size: 26,048

%S System bits size (non-configurable): 128

%SW System words size (non-configurable): 168

%KW Constant words configurable memory size:
• default size: 128
• maximum size: 26,048

Setting Default and Maximum Values

You can reset the CPU configuration properties to:
• default values
• maximum values
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The value editing window for default values and for maximum values are similar in
appearance. One lists the default value for each configurable property, the other
lists maximum values for each configurable property. The Default Values window:

To reset CPU configuration parameters, follow these steps:

Step Action

1 Click one of the following command buttons on the Configuration tab:
• Default values to reset parameters to their default values
• Maximum values to set parameters to their maximum values

Depending on the button you push, a window opens displaying the default or maximum
values for each parameter.

2 In the Default values / Maximum values window, place a check mark next to each
setting you want to set to either its default of maximum value.

NOTE: You can manually place a check mark next to one parameter at a time, or
click Select All to select all parameters at once.

3 Click OK to edit the selected parameter values.
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Using the State RAM Viewer

State RAM Memory Viewer

The following screen displays the content of the state RAM memory areas of the
Momentum processor:

NOTE: The state RAM viewer is directly accessible via the Control Expert
main menu at:

• PLC > State Ram Viewer
Description of the screen zones

Zone Description

Table This table represents the mapping of the memory area selected with the
Memory Area selection buttons.

The occupied memory addresses are marked by dashes:
• blue: for module type objects
• red: for objects entered in the program
• green: for objects defined in the variable editor

The scroll bars can be used to access the entire memory area.

Modules,
Variables, and
Language
check-boxes

These check-boxes are used to filter the information displayed in the table. If for
example, Modules is the only checkbox that is selected, only module-type
information is displayed.

Address
information

By entering the object and its address in the Address fields and clicking the Go
To button, you display directly the address in the table (without using the scroll
bars). This zone also has a display function; it displays the object and address
of the box selected in the table. For module-type objects, it also gives the
topological address of the module concerned.

Memory Area
selection buttons

These buttons are used to select the memory area to display in the table:
• %M (0x) output bits and internal bits
• %I (1x) input bits
• %IW (3x) input words
• %MW (4x) output words and internal words
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Configuring Serial Communication for the 171 CBU 78090, 171
CBU 98090 and 171 CBU 98091 Processors in Control Expert

Overview

This section describes how to configure the 171 CBU 78090 171 CBU 98090 and
171 CBU 98091 processor for serial communication in Control Expert.

Accessing Serial Link Parameters in Control Expert

Configuring the Processor as a Modbus Slave

The following steps show you how to access the serial port configuration screen
for the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors in
Control Expert. Use the Control Expert configuration screens to configure a
processor for serial link operation in Modbus slave mode.

NOTE: You can use L9_XMIT or XXMIT function blocks to configure a serial
link to operate in either Modbus master mode or character mode.

During run-time, these function blocks overwrite the serial port configuration
settings in Control Expert. After these function blocks have finished executing,
the serial link retains the settings written to the serial port by these function
blocks. To restore the original serial port settings, cycle power to the processor
or download the original configuration to the processor.

Accessing the Serial Link

To access the serial link, follow these steps:
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Step Action

1
In the project browser, navigate to and open Project > Configuration > Momentum
Bus > <Processor>:

2 Double-click the Serial Port node to open the Configuration screen:

NOTE:
• The 171 CBU 78090 configurable RS232/RS485 serial port uses Channel 0.
• The RS485 fixed serial port uses at Channel 1.

Serial Link Parameters and Settings in Control Expert

Configuring Modbus Slave Settings

Use Control Expert to configure serial ports on the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors as Modbus slaves. The range of available
settings depend on the port you are configuring:

• the configurable RS232/RS485 serial port on the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors, which operates at channel 0

• the fixed RS485 serial port on the 171 CBU 78090 processor, which operates
at channel 1
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Serial Link Parameters

The following parameters can be configured in Control Expert for operation of the
serial link in Modbus slave mode:

Parameter Fixed RS232 Port 171 CBU
78090

Configurable RS232/RS485 Port 171 CBU
98090 & 171 CBU 98091

Operation Mode Modbus (fixed) Modbus (fixed)

Modbus type Slave (fixed) Slave (fixed)

Slave number,
page 46

1...247, 248; default = 1 1...247, 248; default = 1

Physical line,
page 47

RS485 (fixed) • RS232 (default)
• RS485

Signals, page 47 RX/TX (fixed) • If RS232 is selected:
◦ RX/TX (default)
◦ RX/TX + RTS/CTS DCE mode

• If RS485 is selected:
◦ RX/TX (fixed)

RTS/CTS delay
(ms), page 47

– If RS232 and RX/TX + RTS/CTS DCE mode
are selected:

• 0...10,000 ms in 100 ms increments
default = 0

Transmission
speed (bits/s),
page 48

• 300
• 600
• 1200
• 2400
• 9600 (default)
• 19,200

• 300
• 600
• 1200
• 2400
• 9600 (default)
• 19,200

Delay between
frames (ms), page
48

2...10,000 ms in 1 ms
increments; default = 2 ms

2...10,000 ms in 1 ms increments; default = 2
ms

Data, page 48 • ASCII (7 bits)
• RTU (8 bits) (default)

• ASCII (7 bits)
• RTU (8 bits) (default)

Stop, page 49 • 1 bit (default)
• 2 bits

• 1 bit (default)
• 2 bits

Parity, page 49 • Even (default)
• Odd
• None

• Even (default)
• Odd
• None

Slave Number

Use this parameter to input the processor slave number (or address):

Values include physical addresses 1 to 247, and 248 indicating Modbus slave
point-to-point serial communication. Default = 1.

46 HRB44124.09



Configuring the 171 CBU 78090, 171 CBU 98090 and 171
CBU 98091 Processors in Control Expert 171 CBU 78090, 171 CBU 98090, 171 CBU 98091 Processors

Physical Line

Use this parameter to select the physical line:

You can choose between 2 types of physical lines for the configurable serial port
at port 2 on the processor:

• RS232
• RS485
NOTE: This setting is not editable for the fixed RS485 serial port on the 171
CBU 78090 processor.

Signals

Use this parameter to select the signal used by the physical line:

For RS232 communication, selections include:
• RX/TX (default)
• RX/TX + RTS/CTS DCE mode (typically selected when the processor is

connected to a modem or bridge)
If the RS485 is configured, the entire zone will be grayed out and the default value
is RX/TX.

RTS/CTS Delay

This configuration parameter provides for a delay after a clear to send (CTS)
frame has been received in response to a prior request to send (RTS) frame.

Configure this parameter by inputting a value into the screen element, below:

RTS/CTS delay zone is enabled only when both RS232 and RX/TX+RTS/CTS
DCE mode are selected. An RTS/CTS flow control algorithm is selected if the
default value is 0 ms. A value different from 0 enables an RTS/CTS modem
control algorithm.

The RTS/CTS flow control algorithm (DTE <-> DTE) is different from the RTS/CTS
modem control algorithm (DTE <-> DCE) as follows:

• The RTS/CTS flow control algorithm is related to the overflow reception buffer
(full-duplex).

• The RTS/CTS modem control algorithm deals with the shared transmission
process, for example, a radio modem.
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These algorithms are used for the following purposes:

Algorithm Description

RTS/CTS Flow Control The purpose of this algorithm is to help avoid a reception
buffer overflow. The RTS output signal of each device is
connected to CTS input signal of other device. The
transmitter is authorized to transmit data when receiving the
RTS input signal on its CTS input. This algorithm is
symmetric and allows full-duplex asynchronous
communication.

RTS/CTS Modem Control Before a request is transmitted, the sender activates the
RTS signal and waits for the CTS signal to be triggered by
the modem. If the CTS is not activated after the RTS/CTS
delay, the request is discarded.

Transmission Speed

Use this parameter to select the transmission speed of the Modbus serial link:

Select a speed that is consistent with the other devices on the bus. The
configurable values include 300, 600, 1200, 2400, 4800, 9600 (default), and
19200 bits per second.

Delay Between Frames

Use this parameter to set the minimum time separating two frames on reception:

The specified delay is added when the PLC is receiving messages. This is mainly
used in RTU mode to extend the end of message frame timeout when using
unbuffered modems or other devices that may add delays to the data
transmission. Select Default to apply the default value.

NOTE: The default value depends on the selected transmission speed.
NOTE: Select the default value to be Modbus compliant. Configure the value
so that it is the same for the master and all slaves on the bus.

Data

Use this parameter to enter the type of coding used to communicate over the
Modbus serial link:

Set this field so that it is the same as the other devices connected on the bus.
There are two settings:

• RTU mode (default):
◦ The characters are coded over 8 bits.
◦ The end of the frame is detected when there is a silence of at least 3.5

characters.
◦ The integrity of the frame is checked using a word known as the CRC

checksum, which is contained within the frame.
• ASCII mode:
◦ The characters are coded over 7 bits.
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◦ The beginning of the frame is detected when the ":" character is received.
◦ The end of the frame is detected by a carriage return and a line feed.
◦ The integrity of the frame is checked using a byte called the LRC

checksum, which is contained within the frame.

Stop

Use this parameter to enter the number of stop bits used for communication:

Set this field so that it is the same as the other devices on the bus. The
configurable values include:

• 1 bit (default)
• 2 bits

Parity

Use this parameter to determine whether a parity bit is added or not, as well as its
type:

Set this field so that it is the same as the other devices on the bus. The
configurable values are:

• Even (default)
• Odd
• None

Creating the I/O-Bus

Overview

This section describes how to create an I/O-Bus in Control Expert.

Creating the I/O-Bus in Control Expert

Introduction

The 171 CBU 78090, 171 CBU 98091 and 171 CBU 98091 processors support an
I/O-Bus containing up to 32 Momentum devices. The I/O-Bus supports up to 256
input words, and 256 output words.

Monitoring I/O-Bus Health

The processor monitors the health of each module on the I/O-Bus, and stores
health data in 2 system registers: %SW128 and %SW129. Each bit represents the
health of a module on the I/O-Bus, as follows:

• %SW128.0 stores the health of the module at address 1
• %SW129.15 stores the health of the module at address 32

A bit value of 1 indicates a module is healthy.
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I/O-Bus Branching

The processors support the use of 170 BNO 671 00 branch interface modules to
create a single level of branches on the I/O-Bus.

NOTE: You can create multiple branches using 170 BNO 671 00 branch
interface modules, provided those branches are at the same level. You cannot
create a second level of I/O-Bus branches by adding a 170 BNO 671 00
branch interface module to a branch created by another 170 BNO 671 00
module.

Creating the I/O-Bus

To create an I/O-Bus, follow these steps:

Step Action

1
In the Project Browser, navigate to and double-click the Project > Configuration > I/O-
Bus node:

The I/O-Bus window opens.

2
In the I/O-Bus window, right-click an empty connection point to display the context menu:
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Step Action

3
Select New Device... to open the New Device window.

4 In the New Device window, do the following:
1. Select a device from the list.
2. Enter a Topological Address for the selected device.
3. Click OK.
NOTE:

• The Drop end communicator setting is automatically set to the 170 INT 110
03 Interbus adapter.

• The Topological Address is also referred to as the “drop number”, and
defaults to the next lowest available address, from 1...32.
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Step Action

NOTE: In place of steps 3 and 4, above, you can instead select a device in the
Hardware Catalog and drop it onto an empty connection point. The following version
of the New Device window opens:

In this window, enter a Topological Address and then click OK.

5
In the I/O-Bus window, the selected device–in this example the 170 ADI 350 00 module–
is added:

In the Project Browser, the new I/O base, and communication module appear as a node
on the I/O-Bus:

Click File > Save to retain your edits.
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Addressing on the I/O-Bus

I/O-Bus Addressing

A device address on the I/O-Bus includes the following elements:

Bus number, Drop number, Module ID, Node ID

The following example depicts an I/O-Bus with a single sub-branch.
NOTE:

• You can use the 170 BNO 6x1 00 branching module to create sub-
branches 1-level deep off of the I/O-Bus main branch.

• You cannot use a branching module to create a sub-branch off of a sub-
branch.

• You cannot use the 170 BNO 6x1 00 branching module to enable and
disable remote I/O-Bus branches created by inserting a branching module
onto the I/O-Bus.

Item Addressing Element Description

1 Bus number The I/O-Bus number is a read-only setting assigned by
Control Expert.

NOTE: The Momentum Bus is number 0.

2 Topological address Also known as the ‘drop number’, Control Expert assigns a
default setting equal to the lowest available number from
1...32. This read-write setting is editable in the New Device
window and in the I/O-Bus window.
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Item Addressing Element Description

3 Module number The sequential number of the module on the drop–a read-
only setting assigned by Control Expert.

4 Node ID The sequential number of the module on the entire I/O-Bus–
a read-only setting assigned by Control Expert.

Configuring Momentum Analog I/O Modules

Analog I/O Configuration

Double-click a Momentum analog I/O base unit in the I/O-Bus window to open the
analog I/O configuration window. An example of an analog input module is
depicted, below:

The analog I/O configuration screen includes the following areas:

Area Function

1 Displays the type of analog module, and the number of channels.

2 Click the:
• Module number to display the following tabs:
◦ Overview: contains a text description of the module.
◦ Memory: use this tab to configure State RAM for the module, page 57.
◦ I/O Objects: use this tab to manage I/O objects for this analog I/O module.

• Channel node to display the Adjust tab, where you can configure input or output
settings for the selected channel.

3 Use this area to define the (MAST or FAST) task.

Click Default Parameters to apply the default parameters defined for the module.

4 The tab in the foreground has the focus.

5 Use this area to configure the analog input or output for the selected channel.
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Configuring Discrete Momentum I/O Modules

Discrete I/O Configuration

Double-click a Momentum discrete I/O base unit in the I/O-Bus window to open
the discrete I/O configuration window. An example of a 170 ADM 690 51
configuration screen is depicted, below:

The discrete I/O configuration screen includes the following areas:

Area Function

1 Displays the type of discrete module, and the number of channels.

2 Click the:
• Module number to display the following tabs:
◦ Overview: contains a text description of the module.
◦ Memory: use this tab to configure State RAM, page 56 for the module.
◦ I/O Objects: use this tab to manage I/O objects for this discrete I/O module.

• Channel node to display the Configuration tab, where you can configure input or
output settings for the selected channel.

3 Use this area to define the (MAST or FAST) task.

Click Default Parameters to apply the default parameters defined for the module.

4 The tab in the foreground has the focus.

5 Use this area to configure the discrete input or output for the selected channel.

Configuring the I/O Base: Memory Tab

Overview

Use this tab to configure memory management for the selected input / output
module. Memory management is performed by configuring State RAM.
Topological addressing is not supported.
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State RAM Configuration for Discrete Modules

Depending on the selected discrete I/O module, the State RAM area of the
Memory tab contains parameters for discrete input modules, discrete output
modules or for discrete mixed modules.

The figure below shows the Memory tab for a discrete mixed input / output
module as an example:

The State RAM area contains the following parameters:

Parameter Description

Format • Bit: Select this option for channel mapping in the discrete mode.
This means that each channel is mapped to a %I (inputs) or %M
(outputs).

• Word1: Select this option for channel mapping in the word mode.
This means that a group of 8 channels is mapped to a %IW (inputs)
or %MW (outputs).

Coding This parameter is only available for channel mapping in word mode when
the parameter Format is set to Word.

• Binary: Select this option to use the binary integer format.
• BCD: Select this option to use the BCD coding format.

Mapping This parameter allows you to define the starting address for the inputs
and outputs.

The following sizes of the memory areas are possible:
• For inputs in Bit format: %I-1x
• For inputs in Word format: %IW-3x
• For outputs in Bit format: %M-0x
• For outputs in Word format: %MW-4x

NOTE: The State RAM address starts at address 0, but the first
available address for discrete and analog modules is %I1, %M1, %
IW1, and %MW1.

1. When Word is selected as the Format, the LSB of the Word is mapped to:
• Input 0 on discrete input modules
• Output 0 on discrete output modules

NOTE: Configure every channel of a discrete module. You cannot leave a
group of channels in their non-configured state.
NOTE: You can use State RAM objects in event sections. They are refreshed
with the frequency of the task where they are declared.
NOTE: State RAM addresses are not checked during input. If any range
overlapping is detected or any address exceeds the range of the State RAM,
an appropriate message is displayed during project validation or during the
variable analyze process.
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State RAM Configuration for Analog Modules

Depending on the selected module, the State RAM area of the Memory tab
contains parameters for analog input modules, analog output modules or for
analog mixed modules.

The figure below shows the Memory tab for a mixed analog input / output module
as an example:

The State RAM area contains the following parameters:

Parameter Description

Mapping This parameter allows you to define the starting address for the inputs
and outputs.

The following sizes of the memory areas are possible:
• For inputs in Word format: %IW-3x
• For outputs in Word format: %MW-4x

NOTE: State RAM addresses are not checked during input. If any range
overlapping is detected or any address exceeds the range of the State RAM,
an appropriate message is displayed during project validation or during the
variable analyze process.

Configuring Channels on the 170 AEC 920 00 Counter Module

Using the AEC Function Block

Use the AEC derived function block (DFB) to configure the 170 AEC 920 00
module in Control Expert program logic. Each counter channel requires a
separate AEC DFB.

NOTE: The 170 AEC 920 00 module DFB is not part of the standard EF/DFB
library. To obtain this DFB, you can download it from Schneider Electric
Technical Support at http://eclipse.modicon.com.

Each AEC DFB transmits many set values, one after another, which are then
stored in the data structure par_arr, and returns the current values of the counters.
The data transfer of bytes, words, and double words is started using a 0 -> 1 edge
at the send input. All bits are sent in each scan cycle.

NOTE: If you include a 170 AEC 920 00 module in your configuration, the
module configuration is written to and stored in the first 2 words of %MW
memory (%MW1 and %MW2). You may need to reassign the memory
locations of variables in your application program to avoid memory conflicts.
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AEC DFB Structure

The AEC DFB presents the following structure:

Inputs

Each AEC DFB presents the following outputs:

Parameters Data Type Meaning

Start3x Word Arr 9 1. Address of the 8 input words

Start4xi Word Arr 9 1. Address of the 8 output words

Counter Byte Select counter 1 or 2

send BOOL 0-1 Edge for the data transfer of byte, word, double word
(BOOL values are sent in a cyclic manner)

E_P BOOL Enable acceptance of preset value

E_C BOOL Software Enable for counter

E_CP BOOL Software Enable to freeze counter value

EI_F BOOL Enable input filter

Q1_3_F BOOL Activate forcing of digital outputs Q1/3

Q1_3 BOOL Record Valence of digital outputs Q1/3;

Q2_4_F BOOL Activate forcing of digital outputs Q2/4;

Q2_4 BOOL Record Valence of digital outputs Q2/4;

Mode Byte 4 bits for the choice of operation mode

Pres_Mod Byte 3 bits for the choice of preset mode

D_B BOOL Invert counting direction; effective in all operating modes
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Parameters Data Type Meaning

O_config Byte Configure outputs Q1/2 or Q3/4

L_ED BOOL Monitoring of the counter inputs A, B, Z for a line break.

CLOA BOOL Behavior of Q1 to Q4 during bus interruption

first_bl INT Number of the first data block to be sent

tot_blk INT Total number of data blocks to be sent

par_arr Word Arr 31 Data structure with 31 word data block:

1. word: Reference number

2. word: Set point value (High word)

3. word: Set point value (low word)

NOTE: The data structure par_arr is comprised of 10 blocks.. Each data block
has 3 words, the reference number, the setpoint value (low word), and the
setpoint value (high word).

Outputs

Each AEC DFB presents the following outputs:

Parameters Data Type Meaning

Start4x Word Arr 9 1. Address of the 8 output words

status Byte High-byte of 1st or 2nd input word (Status bits)

error Byte Low-byte of 1st or 2nd input word (detected error bits)

SratioNo Byte Reference number returned (if detected error = 1 F hex)

Q_1_3 BOOL Valence of output Q1 or Q3

Q_2_4 BOOL Valence of output Q2 or Q4

REF BOOL Preset value has been accepted

ECPP BOOL Freeze HW and SW counter values

ECP BOOL Counter has been enabled

PP BOOL Accept preset HW and SW values

RCVA BOOL 1. Count cycle is complete

ACT_VAL DINT Current value or capture value

p_error BOOL Detected transmission error (wrong value)

ready BOOL Data transfer display:

0 = Transmission is active

1 = Transmission is complete

Configuring the Ethernet Port in Control Expert

Overview

This section shows you how to use Control Expert to:
• create an Ethernet network
• link the new Ethernet network to the Ethernet port on the 171 CBU 98090 and

171 CBU 98091 processors
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Configuring the 171 CBU 98090 and 171 CBU 98091 Ethernet Port

Configuring the Ethernet Port

To use the Ethernet port on the 171 CBU 98090 and 171 CBU 98091 processors,
you need to perform the following tasks in Control Expert:

• create an Ethernet network
• link the new Ethernet network to the Ethernet port on the processor

Follow these steps to configure the Ethernet port:

Step Action

1 Create an Ethernet network. In the Project Browser, navigate to Project >
Communication > Networks.

2
Right click the Networks node, and select New Network from the menu:

The Add Network dialog opens.

3
In the Network tab of the Add Network dialog, select Ethernet as the network type,
and accept the default network name (in this example, the default network name
Ethernet_1:

4 Click OK to save the new Ethernet network.

The next task is to associate the new network with the Ethernet port. on the
processor.
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Step Action

5 In the Project Browser, navigate to and open the Project > Configuration folder.

6
Double-click the Momentum Bus node to display the processor on its I/O base:

7 In the Momentum Bus window, double-click the Ethernet port to open the
configuration window for that port.

8
In the Ethernet port configuration window:

1. Select the Ethernet channel.
NOTE: The Ethernet port operates at channel 3 in both the 171 CBU 98090
and the 171 CBU 98091.

2. Select ETH TCP IP in the Function list.
NOTE: Selecting ETH TCP IP in the Function list displays the Task and
Net Link fields.

3. In the Net Link field, select an Ethernet network (here Ethernet_1) to link to the
Ethernet port.

8 In the Control Expert menu bar, click the Validate button; then click the Save button.
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Configuring Ethernet Services

Overview

This section describes how to enable and configure Ethernet services provided by
the 171 CBU 98090 and 171 CBU 98091 processors.

Enabling Ethernet Services

Ethernet Services

The 171 CBU 98090 and the 171 CBU 98091 processors provide the following
Ethernet services:

• Security (for CPU versions 2.0 and higher)
• IP address assignment
• Modbus Messaging and Access Control
• I/O Scanning
• SNMP agent
• Bandwidth Monitoring

The 171 CBU 98091 processor also includes the Global Data automatic data
exchange service.

Both the I/O Scanning service and the Global Data service can be enabled or
disabled using Control Expert. The other Ethernet services remain continuously
enabled during operations.

Enabling Ethernet Services

To enable Ethernet services for the processor:

Step Action

1 In the Control Expert Project Browser, select an Ethernet network by navigating to
Project > Communication > Networks.

2 Double-click an existing Ethernet network. A configuration window for the selected
Ethernet network opens.

NOTE: The Module Family area is read-only and displays the selected processor
type (in this example, CPU M1E-GD).

3 In the Model Utilities area, you can select Yes from the drop-down list to enable:
• IO Scanning
• Global Data (for the 171 CBU 98091 processor)

Security (Enable / Disable HTTP, FTP, and TFTP)

Security and HTTP, FTP, and TFTP Services

Versions 2.0 and higher of the 171 CBU 98090 and the 171 CBU 98091
processors use:
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• HTTP services to provide access to its embedded Web pages.
• FTP and TFTP services to support various features including firmware

upgrades.
The HTTP, FTP, and TFTP services can be disabled or enabled using the Control
Expert Security tab.

HTTP, FTP, and TFTP services are disabled by default.

You can use Control Expert to enable or disable HTTP, FTP, and TFTP services as
described below.

NOTE: Schneider Electric recommends that you disable these services when
you are not actively using them. Leaving these services enabled increases
your system’s vulnerability to cyberattacks.

Using Control Expert to Enable and Disable Firmware Upgrade
and Web Access

Perform the following steps to enable or disable FTP/TFTP or HTTP services on
the module.

Step Action

1 In the Control Expert Project Browser > Structural View, double-click the desired
Ethernet network in the Communication > Networks directory to open the editor for
that network.

2 Click the Security tab.

3 On the Security screen, choose the appropriate setting: (Enabled or Disabled) for
the service or services.

The edits will not take effect until they are successfully downloaded from your PC
to the processor.

Configuring IPAddress Settings in Control Expert

Configurable IPAddress Settings

Use the IP Configuration tab to specify the source that will assign IP address
configuration settings to the processor.

Accessing IP Configuration

To access the I/O Scanning tab:

Step Action

1 In the Project Browser, navigate to the Project > Communication > Networks node.

2 Double-click the appropriate Ethernet network to open its configuration dialog.

3 Select the IP Configuration tab to open that page:
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Step Action

4 Enter the parameter settings for IP configuration. Refer to IP configuration parameters
(below).

5
Click the validate check box in the Control Expert tool bar to confirm the IP
configuration parameter settings.

IP Configuration Parameters

The following IP parameters can be configured for the 171 CBU 98090 and 171
CBU 98091 processors:

Parameter Description

IP address configuration Use the IPAddress Configuration area to specify the source of IP address settings for the processor.

• Configured Select this to assign the following IP address settings in this page:

• IPAddress The IP address of the processor.

• Subnetwork Mask The mask defines the part allocated to the subnetwork identifier in the
IP address.

• Gateway Address The IP address of the default gateway to which messages for other
networks are transmitted.

NOTE: Obtain the appropriate network address and subnetwork mask from your system
administrator. The IP address assignment process is described in the topic describing the Ethernet
port, page 22.

• From a server Select this to let a BOOTP or DHCP server assign IP address settings to the processor.
NOTE: When you select From a server, the manually configured IP parameters have no effect and
are grayed out.

• Device name The device name that is associated with the served IP configuration
in the BOOTP/DHCP server.

NOTE: The processor supports the Ethernet II frame format and complies
with the RFC 894 standard.

Modbus Messaging and Access Control

Modbus Messaging Service

The 171 CBU 98090 and 171 CBU 98091 processors provides a Modbus
Messaging service that permits remote devices to connect to–and communicate
with–the processor. The processor supports up to 16 simultaneous Modbus TCP
server connections.
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Controlling Access

Use the Access Control list in the Messaging tab to restrict access to the
processor in its role as Modbus TCP server. When Access Control is enabled,
only devices with IP addresses added to the list can communicate with the
processor over TCP port 502. The Access Control list can contain up to 128
devices.

If you enable Access Control, consider granting access to the following devices:
• your maintenance laptop
• every target device to which the processor adapter may send a Modbus TCP

message
When Access Control is disabled, any Ethernet device can establish a TCP
connection with the processor.

Navigating to the Messaging Configuration Tab

To open the Messaging tab:

Step Action

1 In the Project Browser, navigate to the Project > Communication > Networks node.

2 Double-click the appropriate Ethernet network to open its configuration dialog.

3 Select the Messaging tab to open that page:

4 Enter the parameter settings for Access Control. Refer to the Access Control
configuration parameters (below).

5 Click the validate check box in the upper tool bar to confirm the Modbus Messaging
parameter settings.

Configuring Access Control

To enable the access control function:
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Step Action

1 In the Connection Configuration area, select Access Control. The Access Control
list is enabled.

2 To grant a remote device permission to access the processor, complete a row in the
list as follows:

• Place a check mark in the Access column.
• Type in the IP address for the remote device.

The added device is permitted to open a TCP connection to the processor when
Access Control is enabled.

3 Repeat step 2 for every remote device–up to 128 devices–that you want to be able to
open a TCP connection to the processor.

NOTE: If you select the Access Control check box but do not enter device
addresses in the Access Control list, no Ethernet communications to or from
the processor can occur.

Modbus TCP Messaging Commands

The processor supports the following Modbus TCP commands

Function Code / Sub-Code Description

FC01 Read coils.

FC02 Read discrete inputs.

FC03 Read multiple registers.

FC04 Read input registers.

FC05 Write single coil.

FC06 Write single register.

FC07 Read exception status.

FC08 / 00 Return query data.

FC08 / 11 Return bus message count.

FC08 / 12 Return bus communication detected error count.

FC08 / 13 Return bus exception detected error count.

FC08 / 14 Return slave message count.

FC08 / 15 Return slave no response count

FC08 / 16 Return slave NAK count

FC08 / 17 Return slave busy count.

FC08 / 18 Return bus character overrun count.

FC08 / 21 Diagnostics Ethernet

FC08 / 22 Retrieving Ethernet channel-specific data from an Ethernet port

FC11 Get communications event counter: for serial line only.

FC12 Get communications event log: for serial line only.

FC15 Write multiple coils.

FC16 Write multiple registers.

FC22 Mask write register.

FC23 Read/write multiple registers.

FC43 / 14 Read device identification.
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I/O Scanning

Introducing I/O Scanning

The 171 CBU 98090 and 171 CBU 98091 processors includes an I/O Scanning
service that exchanges register data with remote devices on the network over
Modbus TCP. The service is enabled using the I/O Scanning configuration tab in
Control Expert.

The I/O Scanning service supports the following Modbus function codes:
• 3: read registers
• 16: write registers
• 23: read/write registers

Use the I/O Scanning service when you want the processor to exchange data with
a remote device at a fixed rate. Suitable applications include:

• fast repetitive communications
• applications that call for communication between one device and many

remote devices, where different data is exchanged with different remote
devices

• applications that need to exchange data to more devices than is possible
using the existing Modbus messaging function blocks

• automatic event handling
• controlling I/O devices

For non-cyclic communications, event-triggered actions, report generation, or
notification of certain events (for example, excessive network or device load
produced by data exchanges), use the Modbus Messaging service, page 64
instead of I/O Scanning.

I/O Scanning Features

The processor includes the following I/O Scanning features:

Feature Description

Number of I/O devices supported 0...32

Size of read per device 0...125 words

Size of write device 0...100 words

Maximum size of total read 500 words

Maximum size of total write 500 words

Maximum size of total read + write 512 words

Repetitive rate 10 ms...60000 ms

Application storage area Non-contiguous %MW

Health status 1 bit per I/O scanning line entry

I/O Scanning Diagnostics

The I/O scanner monitors the health of Modbus communication, and stores health
data in a block of two registers in the %IW memory area.

The control application can interrogate the health block as needed, and the
application can confirm that communication with the remote device is healthy. If a
communications interruption occurs, the application detects it and can respond
based upon the needs of the application.

NOTE: You can also use the I/O Scanning web page, page 94 to view the
status of I/O Scanning.
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Accessing I/O Scanning

To access the I/O Scanning tab:

Step Action

1 In the Project Browser, navigate to the Project > Communication > Networks node.

2 Double-click the appropriate Ethernet network to open its configuration dialog.

3 In the Module Utilities field, select Yes in the IO Scanning menu.

4 Select the I/O Scanning tab to open the I/O Scanning configuration screen:

5 Enter the parameter settings under each of the column headings for one line of the I/O scanner configuration. Refer to I/O
Scanning parameters (below).

6 Click the validate check box in the upper tool bar to confirm the I/O Scanning parameter settings.

I/O Scanning Parameters

The parameters above the table describe how the processor performs the scan:

Parameter Description

Health Block
(%IW)

Use the Health Block field to define the first word in a health table. The health
table has a length of up to 2 words. Each bit in the table represents the status of a
scanned module. The default setting is %IW1.

NOTE: Modules are mapped to health words and bits, as indicated by the
following examples:

• Line 1 is the 1st scanned module and maps to word 1, bit 0.
• Line 16 is the 16th scanned module, and maps to word 1, bit 15.
• Line 17 is the 17th scanned module, and maps to word 2, bit 0.
• Line 32 is the 32nd scanned module, and maps to word 2, bit 15.

Device
Control Block

Use the Device Control Block field to disable I/O Scanning for a selected range
of devices. When I/O Scanning is disabled, a master – for example a PLC – can
assert control over an I/O slave device. When the check box is:

• De-selected (default): I/O scanning is enabled for devices appearing in the I/
O scanning list.

• Selected: I/O scanning is disabled for devices in the range specified by the
From and To IO scanning line numbers, as described in the Health Block
description, above.

NOTE: When I/O scanning is disabled for a device, the I/O scanner
closes the connection to that device and sets the Health Bit to 0
(unhealthy) for that device.

Repetitive
rate step

The Repetitive rate step is set in multiples of 10 ms (the minimum) through 200
ms (the maximum).

The Repetitive rate (ms) column is where you enter a rate of time for how often
you want the I/O scanner to send a query to the device after the rate has timed
out.

NOTE: The Repetitive rate (ms) of the I/O scanner table is a multiple of the
rate displayed in the Repetitive rate step box. The real repetitive rate being
executed by the I/O scanner service is shown in the Repetitive rate (ms)
column.
NOTE: If an entry in the Repetitive rate (ms) column is not a multiple of the
Repetitive rate step, the entry is rounded up to the next multiple.
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The parameters in the table describe the devices to be scanned:

Parameter Description

Entry # Valid range: 1 ... 32

Each entry represents an I/O Scanning exchange on the network.

IP address The IP address of the scanned Ethernet slave device.

Device Name To configure a device (Advantys island, DTM or PRA), click the ... button to open
the Property dialog to start the device configuration software.

NOTE: While the Property box is open, I/O Scanning cannot be edited.

Unit ID The bridge index or slave device number when communicating from an Ethernet
to another network bridging device. If you are using an Ethernet to Modbus
bridge, this indicates the Modbus slave address number. If using an Ethernet to
Modbus Plus bridge, this identifies the bridge index table entry:

• value range: 1 to 255
• default value: 255

Slave Syntax Use this drop-down menu to pick the way RD Ref Slave and WR Ref Slave
values are displayed. The 4 choices are (with an example):

• Index: 100
• Modbus: 400101
• IEC 0: %MW100
• IEC 1: %MW101

Health
Timeout (ms)

This field sets the maximum interval between the responses from a remote
device:

• range: 1 ms to 50 seconds
• interval: 1 ms

After this time period expires, the received data is invalid.
NOTE: Configure the health timeout setting to a longer time value than the
repetitive rate.

Repetitive rate
(ms)

The rate at which data will be scanned, from 10...60000 in multiples of the
Repetitive rate step.

RD Master
Object*

Destination address in the master PLC where, from each device, newly read
information is stored. This parameter cannot be accessed. It is calculated
automatically as the sum of:

• The From address (beginning) of Read ref. (in the zone above the table)
• The RD length value (in the table below)

NOTE: Read and write master locations are non-contiguous.

RD Ref Slave** Source address index in the slave/remote device

RD length Number of words to read
NOTE: If you enter a value greater than the maximum value of 125 words,
Control Expert automatically applies the maximum value of 125 words, then
creates an additional row or rows with the difference.

Last value
(input)

This field configures the behavior of inputs in the event of a detected access
error in relation to the remote device (for example: inoperative network or device
power supply, and so on):

• Set to 0: fall back to 0
• Hold last: maintain last value

WRMaster
Object*

Source address of the master PLC whose data is being written into the slave/
remote device.

This parameter cannot be accessed. It is calculated automatically as the sum of:
• The From address (beginning) of Write ref. (in the zone above the table)
• The WR length value (in the table below)

Write operations are performed at the word level.

WR Ref
Slave**

The address of the first word written into the slave/remote device.

WR length Number of words to be written.
NOTE: If you enter a value greater than the maximum value of 100 words,
Control Expert automatically applies the maximum value of 100 words, then
creates an additional row or rows with the difference.
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Parameter Description

Description Additional information

*Master refers to the client PLC that makes the request.

**Slave refers to the server from which data is read or to which data is written.

Global Data

Introducing the Global Data Service

The Global Data service in the 171 CBU 98091 processor provides an automatic
data exchange for the coordination of PLC applications. Its key features include:

• data exchanges based on a standard producer/consumer protocol, giving
optimal performance while maintaining a minimum network load

• real-time exchanges between stations in the same distribution group, which
share variables used for PLC coordination

• synchronization of remote applications
• sharing of a common database among several distributed applications

Global Data Distribution Group

A Global Data distribution group consists of one or more stations on the same
Ethernet subnet that exchange data variables. The following rules govern a Global
Data variable distribution group:

• A Global Data distribution group can consist of up to 64 stations.
• A Global Data variable distribution group is identified by its Group Name,

which is assigned in the Control Expert Data Editor.
• There can be only one Global Data variable distribution group per logical IP

subnet.
• Each station in a variable distribution group operates on the same Class D IP

multicast address with a configurable range of 224.0.0.0 through
239.255.255.255.

Global Data Variables

The following rules apply to the Global Data variable exchanged by stations in the
distribution group:

• A variable consists of a single block of contiguous words.
• Each station can publish 1 variable consisting of up to 128 words.
• Each station can subscribe to a maximum of 64 variables. However, if that

station also publishes a variable, it can subscribe to a maximum of only 63
variables.

• Each station can subscribe to any variable published by another station in the
group.

• Each station has a maximum subscription of 2,048 total words.

Global Data Tab

To access the configuration parameters on the Global Data tab:

Step Action

1 In the Project Browser, navigate to the Communication > Networks subdirectory.

2 Double-click the appropriate Ethernet network to open its configuration dialog.

3 In the Module Utilities field, select Yes in the Global Data menu.

4 Select the Global Data tab:
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Step Action

5 In accordance with your system and application needs, elect and assign the Global Data
configuration parameters, as described below.

6 Configure variables for the Global Data service. (see below)

Global Data Configuration Parameters

The following parameters can be set in the Global data configuration area on
the Global Data tab:

Parameter Description

Health time out Use this field to set the time-out value: from 50...15 000 ms in increments of
50 ms. Default = 200 ms.

Group address Use this to identify the multicast IP address (class D) of the distribution group
to which the station belongs:

• minimum value: 224.0.0.0
• maximum value: 239.255.255.255 (Default)

Distribution
period

Use this field to set the frequency of the publication. The value is multiplied by
10 ms to determine the time between updates. The minimum value is 2,
yielding a minimum frequency of 20 ms.

Group name Input the name that associates a variable from the Data Editor with a
module. Each group name is created in the Control Expert Data Editor.

Multicast filtering Use this check box to turn multicast filtering ON and OFF. Values include:
• None: Disables GRMP. Data will be sent to each end device in the

network. (Default)
• GRMP: Enables GRMP (general router management protocol).

NOTE: Filtering can reduce data flow on large networks. Multicast
filtering requires the use of switches and routers that support the
selected protocol.

Health bit block Input the address for the first word – of 4 contiguous words – that store health
data for the stations that comprise the Global Data distribution group. Default
= %MW9.

Each bit in the sequence of words starting at this address indicates the health
of an associated station. A bit value of:

• 1 = successful publication or subscription
• 0 = the Health time out period elapsed before completion of the

publication or subscription

Configure Global Data Variables

Global Data variables are configured in the Data Editor:
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Step Action

1 In the Control Expert main menu, select View > Structural View to display that view of the project in the Project Browser.

2
Navigate to and double-click Variables and FB Instances:

The Data Editor table (displayed in step 5, below) appears.
NOTE: The Data Editor does not yet display the Global data column.

3 Right-click in the first row in the Data Editor, and select Customize Columns from the menu.

The Customize Columns window appears:

4 In the Customize Columns... dialog, select the Global Data check box, and press OK.
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Step Action

5
The Data Editor now displays the Global data column:

6 In the Global data column, select one of the following for each variable:
• NO: not published and not subscribed
• PUB: published
• SUB: subscribed

7 Associate each Global Data item with a group name in the Group column.

8 Enter the identifier of a remote station in a distribution group in the ID column.

SNMP

Introducing the SNMPAgent

The 171 CBU 98090 and 171 CBU 98091 processors include an SNMP v1 agent.
An SNMP agent is a software component that allows access to the processor
diagnostic and management information via the SNMP service.

SNMP browsers, network management software, and other tools typically use
SNMP to access this data. In addition, the SNMP agent can be configured with the
IP address of up to 2 devices–typically PCs running network management
software–to be the target of event driven trap messages. These trap messages
inform the management device of events such as cold start, and detected
authentication failures.

Use the SNMP tab to configure the SNMP agent in the processor. The SNMP
agent can connect to and communicate with up to 2 SNMP managers as part of
an SNMP service. The SNMP service includes:

• authentication checking, by the processor, of any SNMP manager that sends
SNMP requests

• management of event, or trap, reporting by the processor

SNMP Tab

The following procedure shows how to access the SNMP tab:

Step Action

1 In the Project Browser, navigate to the Communication > Networks subdirectory.

2 Double-click the appropriate Ethernet network to open its configuration dialog.

3 Select the SNMP tab to open the SNMP configuration screen:
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Step Action

4 Enter the parameter settings for the SNMP configuration. Refer to the Configuring SNMP
Properties, page 74 section, below, for a description of SNMP settings.

Configuring SNMP Properties

The processor includes the following SNMP properties:

Property Description

IP address managers:

IP address manager 1 The IP address of the first SNMP manager to which the
SNMP agent sends notices of traps.

IP address manager 2 The IP address of the second SNMP manager to which the
SNMP agent sends notices of traps.

Agent:

Location The device location (32 characters maximum)

Contact Information describing the person to contact for device
maintenance (32 characters maximum).

SNMP manager When this checkbox is:
• selected: The location and contact information are

editable in this page.
• de-selected: Location and contact settings are not

editable in this page.
Default = de-selected.

Community names:

Get Password required by the SNMP agent before executing read
commands from an SNMP manager. Default = public.

Set Password required by the SNMP agent before executing write
commands from an SNMP manager. Default = public

Trap Password an SNMP manager requires from the SNMP agent
before the manager will accept trap notices from the agent.
Default = public

NOTE:
• Traps are sent via UDP port 161.
• You may need to configure trap settings on the

SNMP manager, consistent with trap settings on
the processor.

Security:

Enable “Authentication Failure”
trap

If an unauthorized manager sends a Get or Set command to
the SNMP agent, the agent sends a trap notification message
to the manager. Default = de-selected.
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Bandwidth Monitoring

Introducing Bandwidth Monitoring

You can use the Bandwidth Monitoring service to monitor the 171 CBU 98090 and
171 CBU 98091 processor CPU allocation for each of the following services:

• Global Data, page 70 (for the 171 CBU 98091 processor)
• I/O Scanning, page 67
• Modbus Messaging, page 64

Accessing and Configuring the Bandwidth Tab

The following procedure shows how to access the Bandwidth tab:

Step Action

1 In the Project Browser, navigate to the Communication > Networks subdirectory.

2 Double-click the appropriate Ethernet network to open its configuration dialog.

3 Select the Bandwidth tab to open the Bandwidth Monitoring screen:

4 Configure the Global Data, page 70, I/O Scanning, page 67, and Modbus Messaging,
page 64 services before configuring the Bandwidth Monitoring parameters.

5 Enter the parameter settings for the Bandwidth Monitoring. Refer to the Bandwidth
Monitoring Properties, page 75 section, below, for a description of Bandwidth
Monitoring settings.

Bandwidth Monitoring Properties

The Bandwidth tab includes the following properties:

Property Description

Ethernet Environment -
Potential CPU Load

Select the environment that describes your Ethernet network:
• Isolated: Limits the impact of Ethernet communication on

the scan by limiting the total number of Ethernet
messages (I/O scanner included) polled every second to
500.

• Mastered: Increases the total number of Ethernet
messages (I/O scanner included) polled every second to
1000.

• Open: Increases the total number of Ethernet messages
(I/O scanner included) polled every second to 1600.
◦ 1600 for the 171 CBU 98090
◦ 2200 for the 171 CBU 98091

Global Data information Enter an estimate of the number of publication periods. The
value entered is the estimated average publication frequency
of the distribution (local and remote) group stations.

Messaging information Enter an estimate of the number of transactions per second.
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Controlling Ethernet Messaging

During runtime, Control Expert executes both master (MAST) tasks and Ethernet
messaging (ETH) tasks. Control Expert prioritizes ETH tasks, and executes ETH
tasks before it executes MAST tasks. Because Control Expert prioritizes ETH
tasks, you need to configure Ethernet communications so that sufficient bandwidth
remains for the execution of the MAST tasks.

To accomplish this, you need to:
• separately configure each component of Ethernet communications (Global

Data, I/O Scanning, and Modbus Messaging) to control the bandwidth used
by each service, and

• limit the number of Ethernet messages per second that the CPU may handle.
As indicated above, set the Potential CPU Load value to one of the following
limits:
◦ Isolated: 500 messages per second
◦ Mastered: 1000 messages per second
◦ Open: Either:
⇒ 1600 messages per second for the 171 CBU 98090
⇒ 2200 messages per second for the 171 CBU 98091

To decrease the message load contributed by the Global Data service, increase
the Distribution period setting. Each device on the network can publish 1
variable, and subscribe to up to 63 variables. The estimated loads, below, are
presented in messages per second:

Distribution Period
(ms)

Global Data Variables

8 16 32 64

20 400 800 1600 –

30 267 533 1067 –

40 200 400 800 1600

50 160 320 640 1280

60 133 267 533 1067

70 114 229 457 914

80 100 200 400 800

90 89 178 356 711

100 80 160 320 640

– indicates a value beyond the upper limit of 1600 messages per second

NOTE: When compiling a program, Control Expert considers only subscribed
variables, not published variables. As a result, Control Expert may validate a
program that causes bandwidth overload during runtime. When computing the
bandwidth load required for Global Data, consider both published and
subscribed variable messaging.

To decrease the message load contributed by the I/O Scanning service, increase
the Repetitive rate setting. The estimated loads, below, are presented in
messages per second:

Repetitive rate (ms) I/O Scanned Devices

8 16 32 64

10 800 1600 – –

20 400 800 1600 –

30 267 533 1067 –

40 200 400 800 1600

50 160 320 640 1280

60 133 267 533 1067
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Repetitive rate (ms) I/O Scanned Devices

8 16 32 64

70 114 229 457 914

80 100 200 400 800

90 89 178 356 711

100 80 160 320 640

– indicates a value beyond the upper limit of 1600 messages per second

To decrease the message load contributed by the Modbus Messaging service,
increase the Message Sampling period of the several Modbus clients operating
on the network. The messaging rate can be calculated as follows:

Messaging Rate = ((1/ Message Sampling period) x Objects

This formula includes the following elements:

Element Description

Messaging Sampling period The interval at which messages are processed

Objects The number of devices, either client or server, that are
actively communicating

NOTE: Message rates are solved in 10 ms increments. Messages that exceed
the message rate per 10 ms increment are buffered. Buffered messages are
then added to the next 10 ms time slice.

Programming In Control Expert

Overview

This section presents tips for programming the 171 CBU 78090, 171 CBU 98090,
and 171 CBU 98091 processors in Control Expert.

Programming the Momentum Platform in Control Expert

Overview

The Momentum for Control Expert platform lets you use both IEC and LL984
programming languages when programming your control network projects. When
programming your project in Control Expert, take note of the following
programming rules.

Locating Double-Register Variables at an Even-Numbered
Address

When declaring and locating variables that are double-word data types – for
example DINT, DWORD, REAL, and UDINT – you need to locate the variable
beginning at an even-numbered memory address.

Timing the Execution of XXMIT and L9_XMIT Function Blocks

Your Control Expert application program may contain a multiple of XXMIT or L9_
XMIT function blocks. However, the 171 CBU 78090, 171 CBU 98090, or 171
CBU 98091 processor can execute only one of these blocks at a time per channel.
If your program contains multiple blocks of this type, you may need to insert a
delay into your program – or test the DONE output before activating another block.
In this way, you can avoid the simultaneous execution of these blocks.
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Configuring the Port Number Parameter for XXMIT and L9_XMIT

When specifying a port number for the L9_XMIT and XXMIT blocks, use the
appropriate channel setting for the 171 CBU 78090, 171 CBU 98090, or 171 CBU
98091 processor. Channel setting values are:

• 0, representing the MB1/channel 0 configurable RS232/RS485 serial port
• 1, representing the MB2/channel 1 fixed RS485 serial port

Location of Output Data from the XXMIT Block

Control Expert writes XXMIT block output data to the memory location specified in
word 5 of the MsgOut parameter. In this respect, Control Expert XXMIT block
behavior mirrors that of the L9_XMIT block in Concept and Proworx.

NOTE: The behavior of the XXMIT block for other platforms, for example
Quantum, is different than for Momentum In the case of Quantum, for
example, XXMIT block output data is written to the location specified by the
MsgIn parameter.

State RAM Objects Index Range for Modbus Server

The state RAM objects %I, %M, %IW, and %MW each has an index starting at 0.
In the CPU configuration screen, page 40, when the number of objects is entered
– for example 256 – the object index range is [0...(number-1)] or in this example
[0...255].

Modbus server allows access of state RAM objects starting at index 1, for
example [1...255]. Therefore, if you want to have 256 objects accessible with
Modbus requests, you need to enter 257 in the CPU configuration screen, page
40.

Locating 32-Bit Words on Even-Numbered Word Boundary

When assigning a 32-bit variable a memory location, or otherwise locating a 32-bit
double word, you need to locate the variable or word to begin on an even word
boundary.

Momentum-Specific System Words

Contents of this Section

This section describes the system words %SW128 to %SW152 for Momentum
processors.

WARNING
UNEXPECTED APPLICATION BEHAVIOR

Do not use system objects (%Si, %SWi) as variable when they are not
documented.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Description of System Words %SW128 to %SW152

Detailed Description

WARNING
UNEXPECTED APPLICATION BEHAVIOR

Do not use system objects (%Si, %SWi) as variable when they are not
documented.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Description of system words %SW128 to %SW152 on Momentum processors

Word

Symbol

Function Description Ini-
tial
State

%SW128...
%SW129

I/O-Bus
module
health

%SW128.0 is module #1 health; %SW129.15 is module
#32 health. If a health bit is set to:

• 0 = the module is not healthy or the module is not
configured

• 1 = the module is healthy

0

%SW132 I/O
compatibility
detected
error status

NOTE: The content of this word is significant only if %
S118 is set to 1.

Meaning of the different bits of the word %SW132.0 to %
SW132.15:

• %SW132.0 to %SW132.14: These bits contain a
value from 1 to 64, signifying the network position of
the module that cannot be reached. For example, a
value of 8 indicates a detected communications
failure in accessing the eighth module on the network.

• %SW132.15:
◦ %SW132.15 = 0 indicates a detected general

communication stoppage; for example: no power
to the module or a break in its input cable.

◦ %SW132.15 = 1 indicates that communication is
possible, but the I/O bus ID received from the
module does not match the module type
contained in the configuration for that position.

0

%SW134 I/O-Bus
detected
error

Meaning of the values of the word %SW134:
• 0 = no error detected
• 1 = module ID mismatch
• 2 = I/O base detected error
• 3 = missing modules or extra module
• 4 = bus exchange detected error

NOTE: %SW134 stores the last detected error. The
system does not automatically reset this word to 0
when the cause of the detected error o longer exists.
You need to set this word to 0 after resolving the cause
of the detected error.

0

%SW135 Local I/O
detected
error

Meaning of the values of the word %SW135:
• 0 = no error detected
• 1 = read local I/O base ID detected error
• 2 = I/O base ID does not match the application

configuration
• 3 = I/O base detected errors

NOTE: %SW135 stores the last detected error. The
system does not automatically reset this word to 0
when the cause of the detected error o longer exists.
You need to set this word to 0 after resolving the cause
of the detected error.

0

%SW137 Modbus
slave
address -
serial port 2

Read-only system word containing the Modbus slave
address for serial port number 2.

0
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Word

Symbol

Function Description Ini-
tial
State

NOTE: Applies to Momentum processors with 2 serial
ports, for example the 171 CBU 78090.

%SW138 Messages
transmitted -
serial port 2

Read-only system word containing the number of
messages transmitted to serial port number 2.

NOTE: Applies to Momentum processors with 2 serial
ports, for example the 171 CBU 78090.

0

%SW139 Messages
received -
serial port 2

Read-only system word containing the number of
messages received by serial port number 2.

NOTE: Applies to Momentum processors with 2 serial
ports, for example the 171 CBU 78090.

0

%SW141...
%SW142

IP netmask These words contain the following data:
• %SW141: the IP subnet mask low octets
• %SW142: the IP subnet mask high octets

NOTE: Applies to Momentum processors with an
Ethernet port, for example the 171 CBU 98090 and
171 CBU 98091.

0

%SW143...
%SW144

IP gateway These words contain the following data:
• %SW143: the IP default gateway address - low octets
• %SW144: the IP default gateway address - high

octets
NOTE: Applies to Momentum processors with an
Ethernet port, for example the 171 CBU 98090 and
171 CBU 98091.

0

%SW145...
%SW147

MAC address These words contain the following data:
• %SW145: the MAC address - low octets
• %SW146: the MAC address - middle octets
• %SW147: the MAC address - high octets

NOTE: Applies to Momentum processors with an
Ethernet port, for example the 171 CBU 98090 and
171 CBU 98091.

0

%SW148 ETH services
status

These words contain the following data:
• %SW148: FDR client status:
◦ 0 = not initialized
◦ 1 = IP initialized
◦ 2 = <not used>
◦ 3 = link ETH down
◦ 4 = duplicate IP detected
◦ 5 = waiting for server
◦ 6 = no configuration, or configuration detected

error

0

%SW151...
%SW152

ETH open
connection
number

These words contain the following data:
• %SW151: the number of open connections in server

mode
• %SW152: the number of open connections in client

mode

0
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Converting and Importing Legacy Applications

Overview
This chapter describes how to use Control Expert to:

• Convert and import a legacy Momentum application, developed in Proworx,
Concept, or Modsoft, to a Control Expert application.

• Identify those parts of your legacy application that you may need to edit in
Control Expert to complete the conversion process.

This chapter also describes how to adapt existing serial port wiring and reconnect
it to a replacement 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091
processor.

Importing and Converting Legacy LL984 Applications in Control
Expert

Importing Momentum Legacy Applications

Control Expert can import and convert legacy Momentum applications originally
created with other programming software. You can import the following legacy
LL984 applications:

• Concept Projects (*.ASC)
• Modsoft Projects (*.CFG)
• ProWORX32 Databases (*.PWX)
• ProWORX Nxt (*.DCF)

When you import an application to Control Expert from other programming
software, some functions may behave differently.

For example:
• Cold start behavior of Control Expert LL984 applications is different from

legacy LL984 applications.
• Imported Concept IEC coils behave differently than imported LL984 coils.
• Unit Pro MATH functions might not behave the same as legacy LL984

(overflow, underflow, etc.).
• Forced outputs will not retain their forced state in Control Expert on the

occurrence of any one of the following events:
◦ cold start
◦ application download
◦ setting system bit %S0 to 1
By contrast, forced outputs retain their forced state in Concept, Modsoft and
ProWORX projects on the happening of any of these events.
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WARNING
UNINTENDED EQUIPMENT OPERATION
• After you imported an application program, edit the result carefully to check

that the logic elements have been ported completely and are located
correctly in the program.

• Test the application before running it to check that it performs as expected.
• If necessary, edit the program to add logic elements that are missing,

remove code that is not necessary, and replace logic elements that behave
differently from their intended purpose.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Importing Legacy Project Files

To import and convert a legacy project file:

Step Action

1
In Control Expert, select File > Open to display the Open dialog:

2 Select the desired File of type:
• Concept Projects (*.ASC)
• Modsoft Projects (*.CFG)
• ProWORX32 Databases (*.PWX)
• ProWORX Nxt (*.DCF)

3 Navigate to and select the desired legacy application, then click Open. The import
process begins.
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Step Action

4
After a few seconds, the LL984 Options dialog opens.

Use the LL984 Options dialog to input settings that will configure the import process, as
described below.

5 In the Symbols area, select one of the following:

• Original Select this option to use the original variable names of the
legacy application in your new Control Expert application.

• _XYYYYY Select this option to automatically convert the legacy variable
names. The new variable names will be composed according
to the following list:

• _: an underscore will be the leading sign of the
converted variables.

• X: represents the data type in the memory area.
◦ 0: %M (memory bit)
◦ 1: %I (discrete input)
◦ 3: %IM (input word)
◦ 4: %MW (memory word)

• YYYYY: represents the address number.
For example _400001 stands for%MW1.

6 In the Target PLC Family area, select Momentum.

7 Select the Label causes SR checkbox, to import a segment containing labels as an SR
segment, even if its scheduling does not express this. Labels are allowed only in SR
segments.

8 Click OK to save your settings. The options dialog closes.
NOTE: The Full Topological selection does not apply to Momentum projects.
Momentum uses State RAM addressing.

9
If the legacy application contains custom data types, the following dialog opens:
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Step Action

10 Select Show hierarchical tree to expand the list of types.

11 Select each type to include in the imported project.

12 Click OK to save your settings. The dialog closes.

13
When the import process is complete, the following dialog displays:

14 Click OK to close the dialog.

Post Import Clean-up

The import process may not successfully convert every element of the legacy
application. In this case, you need to manually edit the application to complete the
conversion process.

Use the tabs in the Control Expert Output Window to determine what manual
edits you need to make to complete conversion of the legacy application:

• After the import process finishes, the Import/Export tab of the Control Expert
Output Window displays a message for each legacy application element. If
the message is the color:
◦ gray: the item converted successfully
◦ red: the item was not converted successfully
◦ blue: this text describes the cause of the item in red above it

• Use the Build > Analyze Project command to determine if your edits
resolved the detected conversion errors. The Analyze Project tab of the
Control Expert Output Window displays any detected errors.

• Use the Build > Rebuild All Project command to build the application.
Control Expert displays any detected errors in the Rebuild All Project tab of
the Control Expert Output Window.

• Use the Build > Build Changes commands to build your edits to the
application. The Build Changes tab of the Control Expert Output Window
displays any detected errors.
When you double-click a blue text message in the Output Window, Control
Expert opens a window displaying the source of the detected problem.

Control Expert logs the conversion process, and stores the log file in the same
location as the original legacy application file. You can examine the log file to
locate the legacy application elements that need to be manually converted.

Re-Wiring an RS485 4-Wire Serial for 2-Wire Operations

Re-Wiring the Serial Port

The serial ports on the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091
processors support 2-wire RS485 communication. Some existing Momentum
networks may include devices that employ 4-wire RS485 communication. In such
cases, you need to convert the existing 4-wire connections to 2-wire connections
at the processor.

The solution is:
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• join together the Tx+ and Rx+ signals, then connect them to pin 3 (D1) of an
RJ45 serial port connector on the processor

• join together the Tx- and Rx- signals, then connect them to pin 6 (D0) of an
RJ45 serial port connector on the processor

• connect the single-wire Gnd signal to pin 5 (Gnd) of an RJ45 serial port
connector on the processor

These wiring changes are depicted, below:

Every other pin on the processor RJ45 serial port connector, page 19 is reserved,
except for pin number 8, to which a cable shield is connected if you are using
shielded wiring.

RJ45 Cable for RS485 Serial Communication

RJ45 to RJ45 RS485 Communication Cable

To support serial RS485 communications on the 171 CBU 78090, 171 CBU
98090, or 171 CBU 98091 processors, you can use the Schneider Electric
TCSMCN3M3M3S2 RJ45 to RJ45 Modbus cable to connect to a remote
Momentum device.

The TCSMCN3M3M3S2 cable has a length of 2 m and presents the following
wiring profile:
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Diagnostics and Maintenance

Overview
This chapter addresses the following tasks:

• How to diagnose the state of the processor adapter using the LEDs.
• How to monitor and diagnose the processor adapter using the embedded

web pages.
• How to upgrade the processor adapter firmware.
• How to help stabilize the CPU and I/O base installation using the Schneider

Electric high vibration kit.

LED Diagnostics

Overview

Use the LEDs on the front of the 171 CBU 78090, 171 CBU 98090 and 171 CBU
98091 processors to monitor and diagnose the state of the CPU and CPU
communications.

171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 CPU Status LEDs

CPU Status LEDs

The LED panel on the 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091
processors includes the following LEDs you can use to diagnose the CPU status:

• RUN (green)
• ERR (red)
• I/O (red)

Diagnosing the CPU Status

The state of each of these 3 LEDs–blinking, ON, or OFF–collectively describe the
CPU status, as follows:

RUN ERR I/O CPU State

Blinking1 Blinking1 Blinking1 The CPU is booting, or is performing power-up self
tests, or detects a missing or invalid OS.

OFF Blinking1 OFF The CPU is not configured.

Blinking1 OFF or
Blinking1

OFF or ON A valid application is in the CPU. The CPU is in stop
state.

• A blinking ERR LED indicates that a minor CPU
error, page 88 has been detected. The
processor can continue to operate.

• Solid ON I/O LED indicates a local I/O error,
page 88 or an I/O-Bus error, page 88 has been
detected.

ON OFF or
Blinking1

OFF or ON The CPU is in run mode.

Blinking1 ON OFF A firmware transfer is in progress.

1. ON for 250 ms, OFF for 250 ms, repeated continuously.
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171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 Communication Status LEDs

Communication Status LEDs

The LED panel on the 171 CBU 78090 (M1), page 12 processor includes the
following LEDs you can use to diagnose the state of communication over the 2
serial ports:

• MB1 CH0 (yellow)
• MB2 CH1 (yellow)

The LED panel on the 171 CBU 98090 (M1E) and 171 CBU 98091 (M1E-GD)
processors, page 15 includes the following LEDs you can use to diagnose the
state of communication over the serial and Ethernet ports:

• MB1 CH0 (yellow)
• ETH STS (green)
• ETH LNK/ACT (green)
• ETH 100 (green)

Diagnosing Communication Status

The state of each of these LEDs describes the communication status for each
processor, as follows:

LED Processor Flash Pattern Communication State

M1 M1E &
M1E-GD

MB1 CH0 X X flashing1 Data exchange (RX or TX) on the configurable RS232/RS485 serial port
(channel 0) in progress.

OFF No data exchange on the serial connection.

MB2 CH1 X flashing1 Data exchange (RX or TX) on fixed RS485 serial port (channel 1) in progress.

OFF No data exchange on the serial connection.

ETH STS X ON Communication OK.

2 flashes2 Invalid MAC address.

3 flashes2 Ethernet link not connected.

4 flashes2 Duplicate IP address.

5 flashes2 Waiting for served IP address.

6 flashes2 Operating using default IP address.

ETH LNK/
ACT

X ON Ethernet link detected; no communication activity.

OFF No Ethernet link detected.

flashing Data exchange on the Ethernet link in progress.

ETH 100 X ON Ethernet transmission at 100 Mbits/s (fast Ethernet).

OFF Ethernet transmission at 10 Mbits/s, or no Ethernet link detected.

1. ON for 200 ms, OFF for 200 ms, repeated continuously.

2. ON for 200 ms, OFF for 200 ms, repeated N times, followed by OFF for 1000 ms.

CPU Status Detected Error Codes

Introduction

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors can detect
errors during run-time. There are 4 types of reported detected errors:

• Local I/O detected errors
• I/O-Bus detected errors
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• Minor CPU detected errors
• Major CPU detected errors

Local I/O Detected Errors

A local I/O error is detected when:
• The processor cannot read the ID of the I/O base.
• The ID of the local I/O base does not match the configured I/O base.
• The I/O base triggers the detection of an error

If a local I/O error is detected, the RUN LED blinks ON and OFF, and the ERR
LED is ON.

When a local I/O error is detected, the current I/O transmission is dropped.

The cause of a detected local I/O-Bus error is stored in the register located at %
SW135 with the following values:

• 0 = no detected error
• 1 = error detected while attempting to read the I/O base ID
• 2 = I/O base mismatch detected (the I/O base ID does not match the I/O base

ID in the application)
• 3 = I/O base errors detected

I/O-Bus Detected Errors

An I/O-Bus error is detected when one of the following events occurs:
• The ID of the remote processor does not match the configured processor ID.
• The I/O base triggers the detection of an error.
• The processor detects a missing or extra processor on the I/O-Bus.
• The processor detects an I/O-Bus exchange error.

The cause of a detected I/O-Bus error is stored in the register located at %SW134
with the following values:

• 0 = no detected error
• 1 = module ID mismatch
• 2 = I/O base errors detected
• 3 = missing or extra module
• 4 = detected bus exchange error

The processor also provides a compatibility status in a register located at %
SW132, which is significant only when %S118 is set to 1. The compatibility status
register can have the following values:

• bits 0 to 14: Contain a value from 1 to 64, which indicates the network position
of the module that cannot be reached.

• bit 15:
◦ A value of 0 indicates a general communication interruption.
◦ A value of 1 indicates that communication with a module is possible, but

the detected module is not of the configured module type.

Minor CPU Detected Errors

A minor CPU error is detected when the processor enters the Halt state. No action
is needed to clear a minor detected error. The processor can continue to operate.

When a minor CPU error is detected, both the RUN and ERR LEDs blink ON and
OFF.
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Major CPU Detected Errors

When a major CPU error is detected, the processor enters the Stop state. The
processor cannot continue to operate. A major CPU detected error can have many
causes.

For diagnosing detected errors, use the following system words:
• %SW125: last detected error
• %SW126 and 127: address of the program instruction that generated the

detected error
For a description of system bits and words, including detected error descriptions,
refer to the System Bits and System Words topic in Control Expert help.

When a major CPU error is detected the RUN LED is OFF, and both the ERR and
IO LEDs remain ON.

To clear a major detected CPU error, you need to cycle power to the processor.
The processor performs a cold start, and restarts in Stop state.

Web Server Diagnostics

Embedded Web Server

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors provide an
embedded web server. Use the web server to display real-time diagnostic data for
both the processor and other networked devices.

To access the web pages:
• on the 171 CBU 78090: Use the USB port.
• on the 171 CBU 98090 or 171 CBU 98091: Use either the USB port or the

Ethernet port.
The collection of web pages depends upon the specific processor, as follows:

Web Page Processor

171 CBU 78090 171 CBU 98090 171 CBU 98091

Home, page 90 X X X

Diagnostics, page 90 X X X

CPU Status, page 90 X X X

Ethernet Statistics,
page 97

– X X

Global Data, page 93 – – X

I/O Scanning, page 94 – X X

Messaging, page 95 – X X

Bandwidth Monitoring,
page 96

– X X

Properties, page 99 X X X

Monitoring, page 99 – X X

Data Viewer, page 100 – X X

X indicates the processor includes the specified web page.

– indicates the processor does not include the specified web page.

NOTE: Web pages are read-only.
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Accessing the Home Page

Connecting to the Home Page

Navigating the pages of the embedded web server begins by connecting to the
Home page.

To connect to the Home page:

Step Action

1 Connect a PC with an Internet browser to the processor. If the processor is an:
• 171 CBU 78090: Connect the PC to the USB port.
• 171 CBU 98090 or 171 CBU 98091: Connect the PC to either the USB port or the

Ethernet port.

2 Open an Internet browser on the PC.

3 • If your PC is connected to the Ethernet port:
◦ Type in the IP address of the processor, page 22.

NOTE: Use a PC that has been assigned an IP address with the same
network address component as the IP address of the processor.

• If your PC is connected to the USB port:
◦ Type 90.0.0.1 as the URL.

4 Press Enter on your keyboard. The Home page opens in your browser.

To navigate to other web pages, where you can monitor the operation of the
processor, select the following main menu commands:

• Monitoring, page 99
• Diagnostics, page 90

Diagnostics Web Page

Using the Diagnostics Page

After connecting to the Home page, page 90, select Diagnostics in the main
menu to open that web page.

Select one of the following links at the left side of the page to open that read-only
diagnostics page:

• CPU Status, page 90
• Ethernet:
◦ Statistics, page 97
◦ IO Scanning, page 94
◦ Messaging, page 95

• Properties, page 99

CPU Status Web Page

Introducing the CPU Status Page

Use CPU Status page to view CPU information, including:
• LEDs status
• processor identification
• processor operating status
• status of local and networked I/O
• application identification
• select application configuration settings
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Accessing the CPU Status Page

Access the CPU Status page from the Diagnostics, page 90 menu. In the
navigation menu at the left side of the page, select Diagnostics > CPU Status.

An example of the CPU Status page:

CPU Status Data

The CPU Status page displays the following data:

Data Field Description

Status

Reference Present The processor description:
• 171 CBU 78090
• 171 CBU 98090
• 171 CBU 98091

Module State One of the following states:
• NO CONFIGURATION
• IDLE
• STOP
• RUN
• HALT
• INITIALIZING
• ERROR
• OS LOADER

Version Module version

Local IO Health The state of system bit %S119:
• OK
• NOK

IO Bus Health The state of system bit %S118:
• OK
• NOK

Patch The version of the firmware patch, if any:
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Data Field Description

• 0 = no patch
• 1 = version A
• 2 = version B
• ...

Product Range The processor family: a constant value of M1

Product Type Processor (fixed value)

Reference Configured The processor specified in the application:
• M1
• M1E
• M1E-GD

Processor

RAM size (kb) The size of processor RAM in KB

Internal version Firmware version

Hardware ID An identifier for the module hardware. OS Loader checks this
value to determine compatibility between the hardware and the
operating system.

State The operating state of the processor:
• NO CONFIGURATION
• IDLE
• STOP
• RUN
• HALT
• INITIALIZING
• ERROR
• OS LOADER

Error The identity of the last detected error

Calendar Date and time of last detected error

Signature

CID Creation ID: Random number generated when an application is
created. The number remains a constant.

MID Modification ID: Random number generated on each
application modification and rebuild, either partial or global.
When an application is created, MID = CID.

AID AutoModification ID: A new random value is generated for AID
by the PLC after one of the following minor modifications to the
application:

• a Control Expert request to modify %KW
• a P_Unit request that performs a save_param request or

replaces init value
When an application is created or built in local mode, AID = 0.

LID Layout ID: Random number generated after a modification of
the variable layout. LID does not change as a result of a runtime
change either adding or deleting a data block.LID changes only
on when the global rebuild of the application.

LID addresses the needs of Hot Standby. It permits the transfer
of a memory block from the primary PLC to the standby so that
application variables (except for deleted or new ones) exist at
the same location.

LID = CID = MID when the application is created.

DID Data ID: Indicates that a block of data has been freed. Also
used for the special case of remapping a symbol from
unlocated to located.

Application

Name Name of the Control Expert project

Version Project version
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Data Field Description

Creation version Includes both:
• Version and build of Control Expert used to create the

project.
• Date and time the project was created.

Modified version Includes both:
• Version and build of Control Expert used to edit the

project.
• Date and time the project was last edited.

Last Stop The event that last caused the application to stop. Values
include:

• Changeover from RUN to STOP by the terminal or
dedicated input

• Stop on software detected fault (task overrun or SFC
overrun)

• Power loss detected
• Stop on hardware detected fault
• Stop on HALT instruction

Last Stop Date Date an event last caused the application to stop.

Auto run The state of the Automatic Start in RUN setting:
• Yes indicates that the processor is configured to start in

RUN mode after a cold restart.
• No indicates that the option is not selected in the

processor configuration.

Initialize %MW The state of the Initialize %MWi on cold start setting:
• Yes indicates that the processor is configured to initialize

the %MWi internal words on a cold start.
• No indicates that the option is not selected in the

processor configuration.

Application upload Indicates if the application in PLC memory has additional
information (that is, comments) when uploading.

Section protected Indicates if password access is required to edit one or more
sections of the application:

• Yes indicates that a password is required to edit specified
sections of the application.

• No indicates that no password is required for application
editing.

Diagnostic Indicates if the diagnostic buffer has been activated for the
project:

• Yes indicates that Application diagnostics and/or
System diagnostics has been selected in the General >
PLC Diagnostics tab of the Project Settings dialog for
the application.

• No indicates Application diagnostics and System
diagnostics have not been selected.

Forced bit The number of forced bits in the application

IO Bus Devices Status

Configured number The number of I/O devices on the I/O-Bus that are configured in
the application.

Detected number The number of I/O devices on the I/O-Bus that have been
detected by the processor.

Global Data Web Page

Introducing the Global Data Page

The 171 CBU 98091 includes the Global Data diagnostic web page.This page
contains diagnostic data describing the status of the Global Data service.

HRB44124.09 93



171 CBU 78090, 171 CBU 98090, 171 CBU 98091 Processors Diagnostics and Maintenance

Accessing the Global Data Page

Access the Global Data page from the Diagnostics, page 90 menu. In the
navigation menu at the left side of the page, select Diagnostics > Ethernet >
Global Data.

An example of the Global Data page:

The top of this page displays the following read-only diagnostic data for the
Global Data service:

• Global Data Status indicates the status of the service:
◦ OK = operational
◦ NOK = not operational

• Number of Subscriptions per second
• Number of Publications per second

The Global Data page also presents a table representing the nodes in the Global
Data distribution group. The color of each table cell indicates the Global Data
status of that node:

Color Variable Status

green subscribed variable

black published variable

white no published variable and no subscribed variable

red detected communication error for a node that has subscribed to a variable

IO Scanning Web Page

Introducing the IO Scanning Page

The IO Scanning page displays read-only data describing the current state of the
processor in its role as I/O scanner.
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Accessing the IO Scanning Page

Access the IO Scanning page from the Diagnostics, page 90 menu. In the
navigation menu at the left side of the page, select Diagnostics > Ethernet > IO
Scanning.

IO Scanner Display

The top of the page displays the following general diagnostic information about the
scanner:

• I/O Scanning status:
◦ OK indicates that the values in the Scanned Device Status grid represent

the state of scanned devices.
◦ NOK indicates that the processor is not scanning. In this case, any data

that appears in the grid is meaningless.
• Number of transactions per second
• Number of connections

In the Scanned Device Status grid, the colors that appear in each block indicate
the following states for specific remote devices:

• GREEN indicates that a device is being scanned.
• BLACK indicates that I/O Scanning of the specific device has been

intentionally disabled.
• GRAY indicates a device that is not configured.
• RED indicates a suspect device.

When you place your mouse pointer on a block representing a configured remote
device, its IP address is displayed on the top left of the table. When you select a
block representing a configured remote device, the home page of the device is
displayed (if the device includes an embedded web server).

Messaging Web Page

Introducing the Messaging Page

The Messaging page provides dynamically updated data about the open TCP
connections on port 502.
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Accessing the Messaging Page

Access the Messaging page from the Diagnostics, page 90 menu. In the
navigation menu at the left side of the page, select Diagnostics > Ethernet >
Messaging.

Messaging Page Display

The Messaging page provides the following information about each active
connection

Property Description

Connection The connection number: 1...64

Remote address The IP address of the remote device
NOTE: If the remote device includes an embedded web server,
click the Remote address value to open that server and view
the remote device web pages.

Remote port The TCP port for the connection on the remote device

Local port The TCP port for the connection on the processor

Messages Sent The number of messages transmitted over this connection

Messages Received The number of messages received by this connection

Error Sent The number of errors detected on this connection

Bandwidth Monitoring Page

Introducing the Bandwidth Monitoring Page

The Bandwidth Monitoring page provides dynamically updated data about the
current usage of Ethernet bandwidth.
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Accessing the Bandwidth Monitoring Page

Access the Bandwidth Monitoring page from the Diagnostics, page 90 menu.
In the navigation menu at the left side of the page, select Diagnostics > Ethernet
> Bandwidth Monitoring.

Bandwidth Monitoring Page Display

The Bandwidth Monitoring page presents the current percentage usage of
Ethernet bandwidth, in both text and bar graph format:

Color The percentage of bandwidth used by...

Blue Global Data messages

Yellow I/O Scanning messages

Green Modbus Messaging

Gray Other messages, or not used

Ethernet Statistics Web Page

Introducing the Ethernet Statistics Page

Use the Ethernet Statistics page to:
• Display the Ethernet parameters for the processor adapter, including:
◦ MAC address
◦ device name
◦ IP address
◦ subnet mask
◦ gateway (address)

• Display Ethernet statistics for packets, including:
◦ received packets
◦ transmitted packets
◦ collisions

• Reset counting statistics to zero by clicking the Reset Counters button.

Accessing the Ethernet Statistics Page

Access the Ethernet Statistics page from the Diagnostics, page 90 menu. In the
navigation menu at the left side of the page, select Diagnostics > Ethernet >
Statistics.
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An example of the Ethernet Statistics page for the 171 CBU 98090 and 171 CBU
98091 processors:

Ethernet Statistics Data

The CPU Status page displays the following data:

Data Field Description

Ethernet Parameters

MAC Address The factory assigned media access control (MAC) address,
consisting of 6 hexadecimal octet values.

Device Name The name assigned to the processor by the application

IPAddress The Internet protocol (IP) address that has been assigned to the
processor.

Subnet Mask The subnet mask that has been assigned to the processor.

Gateway The MAC address of the remote device, if any, that serves as a
gateway to the processor on the Ethernet network

Transmit Statistics

Frames transmitted OK The number of frames that have been successfully transmitted
(since power was last cycled to the processor or the Reset
Counters button was last pressed).

Collisions The number of times a collision between 2 successfully
transmitted packets was detected on the Ethernet link (since
power was last cycled to the processor or the Reset Counters
button was last pressed).

Excessive Collisions The number of times the processor stopped trying to transmit a
packet after 16 attempts, due to repeated collisions (since power
was last cycled to the processor or the Reset Counters button
was last pressed).

Carrier Sense Errors The number of times that a transmission was interrupted because
the Ethernet link was not present during an attempted
transmission (since power was last cycled to the processor or the
Reset Counters button was last pressed).

Internal MAC Tx Errors The number of frames for which transmission was interrupted due
to an internal MAC sublayer transmit detected error (since power
was last cycled to the processor or the Reset Counters button
was last pressed).

Link Speed The speed of the Ethernet link:
• 10Mpbs
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Data Field Description

• 100 Mbps

Receive Statistics

Frames Received OK The number of frames that have been successfully received
(since power was last cycled to the processor or the Reset
Counters button was last pressed).

Alignment Error The number of mis-aligned packets with at least one of the
following (since power was last cycled to the processor or the
Reset Counters button was last pressed):

• The number of bits in the received packet has an uneven
byte count (not an integral multiple of 8).

• The packet has a frame check sequence (FCS) detected
error

CRC Errors The number of times a cyclic redundancy check error was
detected on an incoming packet (since power was last cycled to
the processor or the Reset Counters button was last pressed).

FCS Errors The number of times a frame check sequence error was detected
on an incoming packet (since power was last cycled to the
processor or the Reset Counters button was last pressed).

Collision Statistics

Late Collisions The number of times a collision was detected after the slot time of
the channel had elapsed since power was last cycled to the
processor or the Reset Counters button was last pressed).

Properties Web Page

Introducing the Properties Page

This web page displays read-only data describing the versions of the following
features of your processor:

• CPU firmware
• web server
• web site, including the collection of web pages and supporting files that

support the display and animation of each web page.

Accessing the Properties Page

Access the Properties page from the Diagnostics, page 90 menu. In the
navigation menu at the left side of the page, select Diagnostics > Properties.

Monitoring Web Page

Using the Monitoring Page

After connecting to the Home page, page 90, select Monitoring in the main menu
to open that web page.

In this page, you can select Monitoring > Data Viewer to open the Data Viewer,
page 100 page.
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Data Viewer Web Page

Introducing the Data Viewer Page

Use the Data Viewer page to view a selected range of dynamically changing data
at 32 contiguous addresses. Specify the address type and the starting address of
the data you wish to view. You can also specify the display format of the data
displayed at each address.

Accessing the Data Viewer Page

Access the Data Viewer page from the Monitoring, page 99 menu. In the
navigation menu at the left side of the page, select Monitoring > Data Viewer.

Using the Data Viewer

To use the Data Viewer, follow these steps:

Step Description

1 Select the address type:
• %IW
• %MW
• %I
• %M

2 Type in a Starting address value.

3 Click Display.

The Data Viewer displays the value of 32 consecutive address values, beginning at
the specified starting address.

4 To specify the display format of data at a specific address, in the Format column,
select:

• bin for binary
• dec for decimal
• hex for hexadecimal
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Upgrading Firmware for the 171 CBU 78090, 171 CBU 98090 and
171 CBU 98091 Processors

Overview

This section discusses how to upgrade firmware on the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors.

Firmware Update with Automation Device Maintenance

Overview

The EcoStruxure™ Automation Device Maintenance is a standalone tool that
allows and simplifies the firmware update of devices in a plant (single or multiple).

The tool supports the following features:
• Automatic device discovery
• Manual device identification
• Certificate management
• Firmware update for multiple devices simultaneously
NOTE: For a description of the download procedure, refer to the
EcoStruxure™ Automation Device Maintenance, User Guide.

Upgrading Firmware with Unity Loader

Using Unity Loader

Use Unity Loader to install firmware upgrades for the 171 CBU 78090, 171 CBU
98090 and 171 CBU 98091 processors. Unity Loader is a stand-alone utility that
ships with your Control Expert software.

Installing Unity Loader

Insert the Unity Loader installation CD in the CD-ROM drive of your maintenance
PC. Autorun launches the setup automatically. If not, double-click Setup.exe. The
Unity Loader Installation Wizard will guide you through the Unity Loader
installation.

Processor Ports

After Unity Loader is installed on your maintenance PC, connect the PC to the
processor. You can connect your maintenance PC to the processor using the
following processor ports:

Processor Port

171 CBU 78090 USB port

171 CBU 98090 USB port

Ethernet port171 CBU 98091

Connecting Unity Loader to the Processor

To establish a connection between Unity Loader and the processor, follow these
steps:
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Step Action

1
Open Unity Loader on your PC: Start > Programs > Schneider Electric > Unity Loader. Unity Loader opens and
displays the Project tab:

2 In the Connection part of the page, make the following settings:

Media Select either:
• Ethernet (for a 171 CBU 98090 or 171 CBU 98091 processor)
• USB (for a 171 CBU 78090, 171 CBU 98090 or 171 CBU 98091 processor)

Address Select or type in the address of the processor, for example:
• SYS (for USB)
• the processor IP address (for Ethernet)

3 Click Connect.

Performing the Upgrade

Before beginning a firmware upgrade, confirm that the processor is in Stop mode.

The firmware upgrade for a processor is contained in a file with an .LDX
extension. The single .LDX file contains the necessary processor firmware
upgrades.

Each of the 3 versions of the processors requires the use of a unique .LDX file.
Before upgrading the firmware, Unity Loader confirms that the firmware upgrade
file is compatible with your processor.

Do not interrupt the firmware download process:
• Do not allow an interruption to the power or the communications during the

firmware upgrade process.
• Do not shut down the Unity Loader software during the upgrade.

If the firmware download process is interrupted, the new firmware is not installed
and the adapter continues to use the old firmware. If an interruption occurs, restart
the process.

Open Unity Loader on your PC and update the firmware for the remote I/O
adapter:
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Step Action

1 After Unity Loader has connected to the module, click the Firmware tab:

2 In the PC area, click the ellipsis (...) button to open a dialog where you can navigate to and select the firmware file for your
Momentum processor. The firmware is contained in a Unity Loader file (.ldx extension).

After you select the firmware file and close the dialog, the selected revision of this firmware is displayed in the list on the
left, and the current version of the firmware is displayed in the list on the right.

3 When the arrow in the middle of the screen (above) is green, click Transfer.
NOTE: Only click Transfer if the arrow is green. A yellow arrow indicates that the firmware file on your computer is
the same version or newer than the file selected for transfer; a red arrow indicates that the firmware on the computer
is not compatible with the Momentum processor.

4
Click yes on the 2 dialogs that appear. A third dialog appears (below), which indicates the transfer status with the blue
bars at the bottom of the screen. After the transfer is complete, click Close.

5 In the Unity Loader software, click Disconnect and close the window.

6 Reboot the processor to finalize the firmware update.

Unity Loader includes its own user documentation. Refer to Unity Loader, User
Guide for assistance when you perform the firmware upgrade.
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Reinforcing the Assembly in a High Vibration Environment

Overview

This section describes how to reinforce the installation of the CPU and I/O base in
a high vibration environment.

Installing the Processor in a High Vibration Environment

Using the High Vibration Assembly Kit

Schneider Electric offers a kit, product 170 XTS 120 00, that you can use to
reinforce the CPU and I/O base assembly in high vibration environments.

You can use the specified kit components in the following circumstances:

Kit Components Image Description

two: screws

two: receptacles

Use these components to reinforce the I/O base only when the
assembly is mounted on a DIN rail:

• Pass each screw from the back of the I/O base through the
hole designed for panel mounting., page 34

• Place each plastic receptacle into the hole on the front of the
I/O base so that it receives a screw.
NOTE: Do not use these components if your CPU and I/O
base are mounted on a panel.

one: 1R connector Use these components to reinforce the assembly of the CPU to an
I/O base that does not include a grille:

• Use a single 1R connector to reinforce the connection
between the I/O base and the CPU at the top of the
assembly.

one: 3R connector

two: 3 connectors

Use these components to reinforce the assembly of the CPU to an
I/O base that includes a grille:

• Use a single 3R connector to reinforce the connection
between the I/O base and the CPU at the top of the
assembly.

• Use 2 number 3 connectors to reinforce the connection
between the I/O base and the CPU at the bottom of the
CPU.

For detailed installation instructions, refer to Schneider Electric publication
31001589, which is delivered as part of the 170 XTS 120 00 kit.

NOTE: Kit components 2, 2R, 4, and 4R are not used to reinforce the
Momentum processors and I/O base assembly.
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Momentum I/O Bases for the 171 CBU 78090, 171
CBU 98090 and 171 CBU 98091 Processors

What’s in This Chapter

Momentum I/O Bases for 171 CBU 78090, 171 CBU 98090 and 171 CBU
98091 Processors ....................................................................................... 106

Overview
The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors are
mounted on a Momentum I/O base.

Momentum I/O Bases for 171 CBU 78090, 171 CBU 98090 and 171
CBU 98091 Processors

Momentum I/O Bases

The 171 CBU 78090, 171 CBU 98090 and 171 CBU 98091 processors are
mounted on a Momentum I/O base. The base provides 5 V power to the
processor.

Use Control Expert to configure the Momentum I/O base units that are listed
below.

NOTE: A processor can be mounted on any Momentum I/O base.
The following Momentum I/O base units are supported in Control Expert:

Module Type Module Name Description Ground
Screw1

IP20 analog input 170 AAI 030 00 ANALOG INPUT 8 CH.DIFF X

170 AAI 140 00 ANALOG INPUT 16 CH.SINGLE X

170 AAI 520 40 RTD,TC,MV INPUT 4 CH.DIFF

IP20 analog output 170 AAO 120 00 ANALOG OUTPUT 4 CH 0-20MA

170 AAO 921 00 ANALOG OUTPUT 4 CH 4-20MA

IP20 digital input 170 ADI 340 00 16 DI 24VDC X

170 ADI 350 00 32 DI 24VDC X

170 ADI 540 50 115VAC 16 PT INPUT

170 ADI 740 50 16 DI 230VAC

IP 20 Mixed Digital I/O 170 ADM 350 10 16 DI/16 DO 24VDC, 0.5A X

170 ADM 350 11 16 DI/16 DO 24VDC,0.5A X

170 ADM 350 15 I/O BASE 24VDC TRUE LOW 16PT IN/OUT X

170 ADM 370 10 16 I 24V/8 O 24V,2A X

170 ADM 390 30 10 DI 24VDC/8 RELAY O

170 ADM 690 51 120V 10PT IN/8PT OUT MDL BASE

170 ADM 850 10 10-60VDC 16 1/16 O MODULE X

IP20 Digital Output 170 ADO 340 00 16 DO 24VDC, 0.5A X

170 ADO 350 00 24V DC 32PT OUT MDL BASE X

170 ADO 530 50 115 VAC OUT - 8 PT - 2A

170 ADO 540 50 115 VAC OUT - 16 PT

170 ADO 740 50 230 VAC OUT - 16 PT
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Module Type Module Name Description Ground
Screw1

IP20 Counter 170 AEC 920 00 HIGH SPEED COUNTER BASE X

IP 20 Mixed Analog I/O 170 AMM 090 00 4 AI/2 AO 4 DI/2 DO X

170 AMM 110 30 ANALOG/DISCRETE MOMENTUM MODULE X

IP 20 Mixed Analog/Digital I/
O

170 ANR 120 90 6 ANALOG IN, 4 OUT/ 8 DIGITAL IN, 8 OUT X

170 ANR 120 91 6 ANLG IN/4 ANLG OUT -10/10V 8 DIG I/O X

170 ARM 370 30 10 POINT IN 24VDC 8POINTREL OUT 120VAC PS X

Branch Interface 170 BNO 671 00 24 VDC I/O BUS (INTERBUS) BRANCH INTERFACE MODULE

1. An ‘X’ indicates the I/O base is designed to accept a ground screw connecting the processor to the base, page 30.
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